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Introduction

The Dell Edge Gateway 3200 supports Windows 10 IoT Enterprise 2019 and Ubuntu 20.04 LTS. The setup procedures for each
of these operating systems are detailed in the following chapters.
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Figure 1. System block diagram

The following table defines the acronyms and abbreviations used throughout this document.

Table 1. Acronyms and abbreviations

Acronym or abbreviation Definition

API Application Programming Interfaces
BIOS Basic Input Output System
CPU Central Processing Unit

DI Digital Input

DO Digital Output

GPIO General Purpose Input Output
HWMon Hardware Monitor

12C Inter Integrated Circuit

LAN Local Area Network

LTSC Long Term Servicing Channel
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Table 1. Acronyms and abbreviations (continued)

Acronym or abbreviation

Definition

PCI

Peripheral Component Interconnect

USB Universal Serial Bus
UWF Unified Write Filter
WDT WatchDog Timer
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This chapter serves as a guide to install and use the Windows 10 loT Enterprise 2019 operating system on the EGW-3200

Setting Up the Windows 10 Operating
System

hardware.

For more information on the Windows 10 operating system, see Microsoft Support.

@lNOTE: For proper Windows boot up, please ensure the BIOS version used is 0.14.10 or above.

Topics:

Boot up and log in

Factory reset

System restore and backup recovery
Security Baseline settings

4G module firmware update procedure
5G module firmware update procedure

Disabling bands in Windows after firmware update or SIM card change

Windows 10 loT Enterprise LTSC basic functions
BMC firmware update procedure

Accessing and updating the BIOS

SuperlO Function Library

Digital Input/Output Function of the Intel PCH Controller
Digital Input/Output Function from PCA9535 GPIO
Hardware monitor AP

Humidity and temperature sensor setup

Pressure sensor setup

Accelerometer sensor setup

Intel OOB

COM Port and Ethernet Names for Mini PCle Cards
Sensor APls

Windows troubleshooting

Boot up and log in

Steps

1.
2.
3.
4. Connect to an available wireless or wired network. After the internet connection is established, the Windows license key is

o

Connect a keyboard, mouse, and monitor to the EGW-3200.

Power on the system. The system boots to the Windows 10 IoT Enterprise LTSC 2019 operating system.
Select your regional settings and keyboard layout. If needed, select the second keyboard layout. Otherwise, skip this step.

activated.
Read and Agree to the End User License Agreement.

. Create a user account with a password.
After login, the system will reboot once for the settings to take effect.

Setting Up the Windows 10 Operating System



https://support.microsoft.com/

Factory reset

About this task

Users can perform a factory reset of the Windows 10 IoT Enterprise 2019 LTSC on the EGW-3200 using the recovery operating
system image on the boot partition. This resets the run-time image back to the standard Windows system, which does not
contain any ODM-installed drivers. Users can download the necessary drivers from the Dell Technologies Support Site.

Steps

Connect a keyboard, mouse, and monitor to the system.

Power on the Edge Gateway and boot to the operating system’s desktop.
Click the Start icon, hold the Shift key and click Restart.

Select Troubleshoot > Reset this PC.

Select Reset this PC > Remove everything.

SN N N NS

Select Fully clean the drive > Reset.

System restore and backup recovery

Create a recovery drive

About this task

To recover from a major issue such as hardware failure, a recovery drive is needed to reinstall Windows 10. This section explains
how to create a USB recovery drive. Personal files and any applications that did not come with the system will not be backed
up.

Use a minimum of 4 GB USB storage and all data in the USB storage will be deleted. Perform the following steps to create a
USB-based recovery drive.

Steps

1. In the search box next to the Start button, search for Create a recovery drive and then select it. You might be asked to
enter an admin password or confirm your selection.

2. When the tool opens, make sure Back up system files to the recovery drive is selected and then select Next.
3. Connect a USB drive to your PC, select it, and then select Next.

4. Select Create. Many files need to be copied to the recovery drive, so this might take a while. After successfully creating the
recovery drive, click Finish.

Create a system image

About this task

After successfully logging into Windows 10, the user can create a system image which can be used to restore the system in case
of a Windows OS crash or hard disk failure.

Steps

1. Select Control Panel and Navigate to Control Panel\System and Security\Backup and Restore (Windows 7).
2. In the Backup and Restore (Windows 7) window, click Create a system image in the upper-left corner.

Setting Up the Windows 10 Operating System 9
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@ Backup and Restore (Windows 7) — [m]

A s « Al Co.. » Backup and Restore (Windows 7) v o

Control Panel Home .
Back up or restore your files

) Creste s system € Backup
i

B Create s sys.em repair disc Windows Backup has not been set up. &p5et up backup

Restore
Windows could not find a backup for this computer,

PSelect another backup to restore files from

See also
Security and Maintenance

File History

4,

10

Figure 2. Create a system image

Windows looks for a backup destination on a hard drive, DVD, or network location. Choose an appropriate destination. Click
Next.

@l NOTE: In the following screenshot, a second SSD storage is used to create the backup.

! 1
1 Create a system image

Where do you want to save the backup?

A system image is a copy of the drives required for Windows to run. It can alse include additional
drives, A system image can be used to restore your computer if your hard drive or computer ever
stops working; however, you can't choose individual items to restore,

(®) On a hard dick

- Mew Volume (D:) 58.90 GB free

== MNew Volume (D:} 58.90 GB free
< Refresh>

(O) On one or more DVDs

(O) On a network location

Select...

Cance

Figure 3. Backup destination

Confirm which areas or partitions of your hard drive will be included in the image file, then click the Start Backup button.

Setting Up the Windows 10 Operating System




&« L‘;t' Create a system image

Confirm your backup settings
Backup location:

- Mew Volume (D)

The backup could take up to 19 GB of disk space.

The following drives will be backed up:

EFl Systern Partition

.E Windows (C:) (System)

Start backup Cancel

Figure 4. Confirm backup

Results

Windows creates the system image file.

Wl Createa system image - s

The backup completed successfully.

Close

Figure 5. Backup completed successfully

Recover from system image

Steps

Connect the USB storage device that was created in Create a recovery drive.

Connect the hard drive or SSD that was used in Create a system image.

After power on, keep pressing Delete and go to the BIOS settings.

From Save and Exit, in Boot Override, select the USB storage device and press Enter.
At the Choose your Keyboard layout page, select the appropriate keyboard layout.

In the Choose an option window, go to Troubleshoot > Advanced Options > System Image Recovery. Follow the
prompts in Windows to restore the system image file.

N N N NS

Results

Once the process is complete, the system restarts and boots into the updated system image.

Setting Up the Windows 10 Operating System 1



Security Baseline settings

The security settings in the image for the EGW-3200 default to those in the standard Windows 10 loT Enterprise release.
However, it is recommended to install Microsoft-provided security policies on top of this to enhance the security features in the
device. Microsoft provides a set of policies called the Security Baseline with each Windows 10 release. Installing this Security
Baseline is a good way to quickly enable recommended security settings on loT devices. The Security Baseline is delivered as
part of the Microsoft Security Compliance Toolkit. Detailed installation and customization instructions are available in the toolkit

package.

4G module firmware update procedure

Steps

1

2.

Download the firmware update tool (.exe) from the EM75xx Approved FW Packages page of the SEMTECH/Sierra Wireless

website.

Windows Linux
7565 Fi PRI G t
5 irmware EXE Binaries ommen

ATET  |SWIPX50C_01.14.13.001 002.062_000] Download | Download

ATET  |SWISX50C _01.14.02.00|002.047_002| Download | Download
Docoma  |SWISX50C_01.09.04.001002.015_002| Download | Download
Generic  |SWI9X50C_01.14.13.00 002.048_000| Download | Download

Approved—Release 20

GCF and FTCRB

Generic ||SWISX50C_01.14.02 00| 002.035_003 Download |, - o
Approved—Release 15
e ;
: R A e e Carrier Approved—
KDD SWISX50C_01.0%.04.00]002.018_002| Download | Download = =
lelease 13
. -~ -

Figure 6. 4G firmware update tool

Right-click the .exe file and run as administrator. The firmware update runs automatically.

5G module firmware update procedure

Download Firmware Selector Tool and driver

Steps

1.
2.

12

Download the Firmware Selector Tool from the EGW-3200 page of the Dell Technologies Support Site.
Unzip the files and open the unzipped folder.

Mame Date modified Type Size

[ SDX55_Thales_USB_x64_20210928_V020_WHQL.. 15-03-2022 09:24
| x64-F0.1.00.9(APO77)_FST_Thales_20220119 14-03-2022 09;

Compressed (zipped). 2,20,451 KB

Compressed (zipped)...

Figure 7. Firmware tool and driver file

Save the driver to the following folder:
\F0.1.0.0.9_AP077\SDX55_Thales_USB_x64_20220208_V023_WHQL_INF_Injection\.

Setting Up the Windows 10 Operating System


https://www.microsoft.com/en-us/download/details.aspx?id=55319
https://source.sierrawireless.com/resources/airprime/minicard/75xx/em_mc75xx-approved-fw-packages/#sthash.nOT5xBmR.5fruUXpH.dpbs
https://www.dell.com/support/home/en-us/product-support/product/dell-edge-gateway-3200/overview

Name

Src
@ devcon
] install_Thales
[%] install_Thales_Include_FOTA
[ ThalseUSBSDx55DriverUninstallToolv0.0.2

Figure 8. 5G firmware driver

Date modified

15-03-2022 09:25
18-03-2019 16:44
09-08-2021 14:18
09-08-2021 14:18
21-06-2021 11:57

Type

File folder
Application
Windows Command ...
Windows Command ...

Application

Size

80 KB
19 KB
22 KB
222 KB

4. Save the Firmware Selector Tool to the following folder: \F0.1.0.0.9_AP077 \x64-F0.1.0.0.9
(AP077)_FST_Thales_20220119\Utilities\x86-Firmware Selector Tool (V2.0.3.3)_Thales.

~

Name

.| Configure data

" Firmware Selector Tool
% GobiConnectionMgmt.dll
[ McFG

% mfc110ud.dll

% msvep110.dll
msvcr100.dll

msver110.dll
% msver110d.dll
[ QDUTool

Figure 9. Firmware Selector Tool

Date modified

15-03-2022 09:25
15-03-2022 09:25
15-03-2022 09:25
15-03-2022 09:25
15-03-2022 09:25
15-03-2022 09:25
15-03-2022 09:25
15-03-2022 09:25
15-03-2022 09:25
15-03-2022 09:25

Remove old and install new drivers

About this task

MV31-W modules require a WIN10 driver. However, this driver must be installed after removing old USB drivers that were

automatically installed by WIN10 PC.

Steps

1. Before connecting the MV31-W module, open the Device Manager, click View, and select Show hidden devices.

Setting Up the Windows 10 Operating System

Type

Configuration settings
Application

Application extension
Application

Application extension
Application extension
Application extension
Application extension
Application extension

Application

Size

1KB
3,734 KB
1,952 KB
331KB
8,042 KB
481 KB
756 KB
843 KB
1,640 KB
144 KB
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.
=4 Device Manager

File  Action Help
& Ep | & | @ | Devices by type
a L= OKBY1LZ Devices by connection
1239 Batt Resources by type
[:> 18 Cor Resources by connection
[> = Disk

Dll"i'l Disp| v | Show hidden devices
Hur
Key
Mice and other pointing devices

Customize...

Manitors

Metwork adapters

Mon-Plug and Play Drivers

Ports (COM & LPT)

Processors

Security Devices

Sound, video and game controllers

VW T T T T T T T T T

OS2 GEAE L BCE [ &

Storage controllers

b -y Storage volume shadow copies
[ - Storage Volumes

[->--;-; Systern devices

B E Universal Serial Bus controllers

Figure 10. Show hidden devices

2. Remove (Uninstall) all devices that start with: Cinterion PID 0x00B3.
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v [ Network adapters

Cinterion PID O0xD0B3 USB Mobile Broadband

v ¥ Modems
«.! Cinterion PID 0x00B3 USB Modem

v @@ Ports (COM & LPT)

v @ System devices

W Cinterion PID 0x00B3 USB Diagnostics (COM10)
7 Cinterion PID 0x00B3 USB Diagnostics (COMZ23)

i3 ACPI Fan
3 ACPI Fan
#m ACPI Fan
fm ACPI Fan
= ACPI Fan

§3 ACPI Fixed Feature Button

£=m ACPI Power Button

§3 ACPI Processor Aggregator

§m ACPI Sleep Button

i3 ACPI Thermal Zone
¢ 1 Cinterion PID 0x00B3 USB Location GNSS
¢ 1 Cinterion PID 0x00B3 USB Location GNSS

Figure 11. Uninstall Cinterion devices

3. Open the driver package folder (SDX55_Thales_USB_x64_20220208_V023_WHQL_INF _Injection) and run

install_Thales.cmd as administrator.

Name

Src
@ devcon

] install_Thales

~

install_Thales_Include_FOTA
[ ThalseUSBSDx55DriverUninstallToolv0.0.2

Figure 12. Run driver command

Date modified

15-03-2022 09:25
18-03-2019 16:44
09-08-2021 14:18
09-08-2021 14:18
21-06-2021 11:57

Update 5G firmware in Windows

About this task

After all the required drivers have been updated, use the Firmware Selector Tool provided by Thales DIS AlS to update the

firmware.

Steps

1. Go to Utilities > Firmware, and select the Firmware Selector Tool.

Setting Up the Windows 10 Operating System

Type

File folder
Application

Windows Command ...

Windows Command ...

Application

Size

80 KB
19 KB
22 KB
222 KB
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Name Date modified Type Size

] Configure data 15-03-2022 09:25 Configuration settings 1KB
“& Firmware Selector Tool 15-03-2022 09:25 Application 3,734 KB
) GobiConnectionMgmt.dll 15-03-2022 09:25 Application extension 1,952 KB
MCFG 15-03-2022 09:25 Application 331 KB
“ mfc110ud.dll 15-03-2022 09:25 Application extension 8,042 KB
msvep110.dll 15-03-2022 09:25 Application extension 481 KB
@] msvcr100.dll 15-03-2022 09:25 Application extension 756 KB
) msver110.dil 15-03-2022 09:25 Application extension 843 KB
“ msveri10d.dll 15-03-2022 09:25 Application extension 1,640 KB
QDUTool 15-03-2022 09:25 Application 144 KB

Figure 13. Firmware Selector Tool

2. The tool will automatically select the ATT T99W175 firmware version to update.

Device : Thales SDx55 Mobile Broadband

Current Firmware : ATT

Firmware Version : TO9W175.F0.1.0.0.9.AT.009

Available Firmware : Revision : 077

Generic T99W175.F0.1.0.0.9.GC.004
Factory Default T99W175.F0.1.0.0.9.0F

| - ATT T99W175.F0.1.0.0.9.AT.009 |
Docomo T99W175.F0.1.0.0.9.00.007
KDDI T99W175.F0.1.0.0.9.KD.008
Orange T99W175.F0.1.0.0.9.0G.005
Swisscom T99W175.F0.1.0.0.9.5C.005
Telefonica T99W175.F0.1.0.0.9.TF.008
Telstra T99W175.F0.1.0.0.9.TE.008
Verizon T99W175.F0.1.0.0.9.VZ.009
Vodafone TS9W175.F0.1.0.0.8.VF.008
Softbank T99W175.F0.1.0.0.9.58.010
CMCC T99W175.F0.1.0.0.9.CC.005
CU T99W175.F0.1.0.0.9.CU.005
CT T99W175.F0.1.0.0.9.CT.005
T-mobile T9SW175.F0.1.0.0.9.TO.006
PNProfile T99W175.F0.1.0.0.9.PN.001

Change Firmware Ancther Page

Figure 14. Firmware to update

3. Wait for the firmware download to finish.
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‘ & Firmware Selector Tool
Device :

Current Firmware :
Firmware Version :

| Available Firmware :

Thales SDx55 Mobile Broadband

Factory Default

MPSS.AT.2.5.1.¢4.3-00006-9655_AUTONCH_I
Revision :

Generic T99W175.F0.0.0.4.6.GC.003
Factory Default T99W175.F0.0.0.4.6.DF
ATT T99W175.F0.0.0.4.6.AT.006
Docomo T99W175.F0.0.0.4.6.00.004

Downloading..

Telstra T99W175.F0.0.0.4.6.TE.005
Verizon T99W175.F0.0.0.4.6.VZ.006
Vodafone T99W175.F0.0.0.4.6.VF.007
Softbank T99W175.F0.0.0.4.6.5B.004
Sprint T99W175.F0.0.0.4.6.SP.005
EE T99W175.F0.0.0.4.6.EE.001
CMCC T99W175.F0.0.0.4.6.CC.002
CU T99W175.F0.0.0.4.6.CU.002

Change Firmware

000

Figure 15. Firmware download status bar

4. Once complete, the Firmware upgrade success message will appear. Click OK.
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Device : Thales SDx55 Mabile Broadband

Current Firmware : ATT
Firmware Version : TOOW175.F0.1.0.0.9.AT.009
Available Firmware : Revision : 77

Generic T99W175.F0.1.0.0.9.GC.004

Factory Default TO9W175.F0.1.0.0.9.0F

ATT T99W175.F0.1.0.0.9.AT.009

Docomo T99W175.F0.1.0.0.9.00.007

KDDI T99W175.F0.1.0.0.9.KD.008

Orange T99W175.F0.1.0.0.9.0G.005

Swisscom T99W175.F0.1.0.0.9.5C.005

Telefonica T98W175.F0.1.0.0.9.TF.008

Telstra T99W175.F0.1.0.0.9.TE.008 i =aiactar Koot L
Verizon TS8W175.F0.1.0.0.9.VZ 009 o s i i
Vodafone T99W175.F0.1.0.0.9.VF.008
Softbank T99W175.F0.1.0.0.8.5B.010
CMCC T99W175.F0,1.0.0.9.CC.005

CU T98W175.F0.1.0.0.9.CU.005

CT T99W175.F0.1.0.0.9.CT.005

T-mobile TS8W175.F0.1.0.0.9.TO.006

PNProfile T99W175.F0.1.0.0.9.PN.001

Change Firmware Another Page

Figure 16. Firmware upgrade success

Disabling bands in Windows after firmware update or
SIM card change

Disabling bands is required if operating the device within the United States, as well as in other locations. The FCC sets
limitations to radiated transmit power (EIRP) that are band-specific. Due to the 4G or 5G module installed, and the antennas
provided by Dell Technologies, certain bands must be disabled. As such, additional commands must be sent to the module, under
certain conditions outlined below, to meet FCC requirements.

Disabling bands is required:

e After the firmware in the module (4G or 5G) is updated
e After a SIM card change to a different telecom carrier

The following instructions provide information on how to correctly disable bands for the 4G or 5G module used in the
EGW-3200.
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Disable bands on 4G device in Windows

About this task

Disabling of these bands is required to meet FCC EIRP or other requirements.

Perform the following steps to disable the bands 42 and 48 on the 4G module.

Steps

1.

10.

Open the Putty application.

Putty is used to send AT commands to the module within the Windows operating system.

Set the COM port to match that of the module in Windows Device Manager.

Under Line discipline options, set both Local echo: and Local line editing: radio buttons to the Force on setting.

In the Configure the serial line window, set the following serial interface parameters for communication with the module:

e Speed (buad): 115200
Data bits: 8

Stop bis: 1

Parity: None

Flow control: XON/XOFF

Configure the serial line

Speed (baud) 1115200 |
Data bits E |
Stop bits |1 |
Parity None v
Flow control XON/XOFF v

Figure 17. Configure the serial line
Open the COM port defined previously using Putty.

Run the following command:

at'!entercnd="A710"

This command is required before any other commands can be sent.

To set a profile called OA that can be called upon with the band mask settings, run the following command:

at!band=0A, "Disable LTE B42,B48",100600000EC00000,00002500BA0E19DF,0000000000000002

To set the profile to OA, as defined in the previous step, run the following command:

at!band=0A

To confirm that band settings are set to OA and not some other setting, run the following command:

at!band?

To reset the device for new band settings to take effect, run the following command:

at!reset

Reset takes a few minutes, then the device is available again.

®| NOTE: Close the Putty terminal immediately after sending this command.
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Disable bands on 5G device in Windows

About this task

Disabling of these bands is required to meet FCC EIRP or other requirements.

Perform the following steps to disable the bands 30, 42, and 48 on the 5G module.

Steps

1.

20

Open the Putty application.

Putty is used to send AT commands to the module within the Windows operating system.

Set the COM port to match that of the module in Windows Device Manager.

Under Line discipline options, set both Local echo: and Local line editing: radio buttons to the Force on setting.

In the Configure the serial line window, set the following serial interface parameters for communication with the module:

e Speed (buad): 115200
Data bits: 8

Stop bis: 1

Parity: None

Flow control: XON/XOFF

Configure the serial line

Speed (baud) 1115200 |
Data bits E |
Stop bits |1 |
Parity None v
Flow control XON/XOFF v

Figure 18. Configure the serial line
Open the COM port defined previously using Putty.

To recover existing default band settings from the module, run the following command:

at”slband

To disable bands 30, 42, and 48, run the following command:
at*slband=LTE,1,30,42,48

This requires a module reset to take effect.
To display band settings to confirm that bands 30, 42, and 48 are disabled, run the following command:

at*slband?

To reset the device for new band settings to take effect, run the following command:
at+reset

Reset takes a few minutes, then the device is available again.
®| NOTE: Close the Putty terminal immediately after sending this command.
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Windows 10 loT Enterprise LTSC basic functions

The EGW-3200 provides various interfaces. The following sections provide further details on these interfaces.

UART controller

For setting the port type of serial ports 1 and 2, change the BIOS settings as detailed in the following table.

Table 2. UART controller settings

S. No Port type Connector Device node BIOS setting configuration

1 RS232/422/485 DB9 COM1 Advanced > Onboard Devices
Configuration > COM1 Control, select
RS232/422/485

2 RS232/422/485 DB9 COM2 Advanced > Onboard Devices
Configuration > COM2 Control, select
RS232/422/485

TPM support

Windows 10 0T Enterprise LTSC 2019 supports TPM 2.0. For more information on TPM resources, see the Trusted Platform
Module Technology Overview from Microsoft.

RHProxy driver - 12C and GPIO

The RHProxy driver enables user mode access to 12C and GPIO (GPIO from the Intel chipset). For details about Windows
RHProxy, refer to Enable user mode access to GPIO, 12C, and SPI. The BIOS of the EGW-3200 is already updated with the
necessary changes for enabling RHProxy for the 12C and GPIO pins.

The following table shows the 12C and GPIO-friendly names and pin mappings.

Table 3. 12C and GPIO names and pin mappings

S No. Peripheral detail Hardware signal name Name/Number to use Comments
with RHProxy
1 GPIO Pin O DO2 0 GPIO number to use for
RHProxy: O
2 GPIO Pin 1 DO3 1 -
3 GPIO Pin 2 DO1 2 -
4 GPIO Pin 3 DOO 3 -
5 GPIO Pin 4 12C1_GPIO 4 [2C1 (CN13) interrupt pin
6 GPIO Pin 5 [2CO_GPIO 5 [2C0 (CN13) interrupt pin
7 GPIO Pin 6 User LED 1 6 -
8 GPIO Pin 7 User LED 2 7 -
9 GPIO Pin 8 User LED 3 8 -
10 GPIO Pin 9 DIO 9 -
M GPIO Pin 10 DN 10 -
12 GPIO Pin 1 DI2 " -
13 GPIO Pin 12 DI3 12 -
14 GPIO Pin 13 DI4 13 -

Setting Up the Windows 10 Operating System
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https://learn.microsoft.com/en-us/windows/security/hardware-security/tpm/trusted-platform-module-overview
https://docs.microsoft.com/windows/uwp/devices-sensors/enable-usermode-access

Table 3. 12C and GPIO names and pin mappings (continued)

S No. Peripheral detail Hardware signal name Name/Number to use Comments
with RHProxy

15 GPIO Pin 14 DI5 14 -

16 GPIO Pin 15 DOA4 15 -

17 GPIO Pin 16 DO5 16 -

System shutdown and restart

Steps
1. Click the Start icon.
2. Click Power, then select Restart or Shut down.

Configure LAN network

Steps
1. Connect an Ethernet cable to the Ethernet port.
The following prompt is displayed:

Networks

TQ Network

Do you want to allow your PC to be
discoverable by other PCs and devices
on this network?

We recommend allowing this on your
home and work networks, but not
public ones.

Figure 19. Prompt for discoverable in network

2. Select Yes.

Optional expansion modules

The EGW-3200 supports several expansion modules, in mini PCl express (mPCle), M.2, and 12C formats. The required Windows
software package is already installed in the Windows image for the following modules. Refer to the website of the manufacturer
for more details.

Table 4. Optional expansion modules

S No. Format Interface details Reference link to manufacturer product
page

1 mPCle EMUC-B202 Isolated Canbus EMUC-B202 Product Page

2 mPCle EMPL-G2P1 GbE with PoE out EMPL-G2P1 Product Page

3 mPCle EMP2-X4S2 Isolated RS-422 and RS-485 EMP2-X4S2 Product Page
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https://www.innodisk.com/en/products/embedded-peripheral/communication-canbus/emuc-b202-1
https://www.innodisk.com/en/products/embedded-peripheral/communication-poe/empl-g2p1-1
https://www.innodisk.com/en/products/embedded-peripheral/communication-serial/emp2-x4s2-1

Table 4. Optional expansion modules (continued)

S No. Format Interface details Reference link to manufacturer product
page

4 mPCle EMP2-X2S1 Isolated RS-232 EMP2-X281 Product Page

5 mPCle EMPL-G201 Isolated GbE LAN EMPL-G201 Product Page

6 M.2 2230 WiFi AX210 Intel Wi-Fi 6E AX210 Product Page

7 M.2 3042 EM7565 4G LTE-Advanced Pro Module EM7565 Product Page

8 M.2 3042 MV31-W 5G Ultra High Speed loT Modem MV31 Product Page

Card
9 Internal 12C wafer ADLINK 55-49071 Isolated DI/O N/A

Configure WWAN network

Prerequisites

Follow the procedures in the service manual to install and configure the WWAN module and the corresponding carrier USIM card
for the system.

About this task

After the WWAN module and the SIM cards are installed, perform the following steps.

Steps

1. Click the Start icon.

. Type Settings and click the Settings app.

2
3. Select Network & Internet.
4

Locate the WWAN connection in the WiFi section and select the entry to connect and disconnect from the WWAN adapter.

Enable Mobile hotspot

About this task

Steps

1. Go to the Mobile hotspot settings in Settings > Network & Internet > Mobile hotspot.

2. Change the Share my Internet connection with other devices setting to On.
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https://www.innodisk.com/en/products/embedded-peripheral/communication-serial/emp2-x2s1-1
https://www.innodisk.com/en/products/embedded-peripheral/communication/empl-g201
https://ark.intel.com/content/www/us/en/ark/products/204836/intel-wi-fi-6e-ax210-gig.html
https://www.sierrawireless.com/iot-modules/4g-modules/em7565/
https://www.telit.com/devices/mv31/

Mobile hotspot

Mobile hotspot
Share my Internet connection with other devices

@D o~

EGW-5200_33360G3
A 2wex
Ary available

1of8
IP address Physical address (MAC)

Unkrown 192.168.137.57

You're shanng your connection aver the 5 GHz network band. The
network might not appear on devices that can only connect over the 2.4
GHz band.

Figure 20. Mobile hotspot settings

3. Confirm that the Network name can be found from end devices, and connect it to ensure that the network function is
working properly.

Configure Bluetooth

Steps

1. Click the Start icon.

2. Type Settings and click Settings.

3. Select Devices from the Settings menu, then select Bluetooth from the menu on the left panel.

Cellular network configuration

If the optional cellular network (4G or 5G) is used, see the Cellular settings in Windows page from Microsoft for information
about configuration and usage.

DSSA

Dual SIM Single Active (DSSA) is the only form of multi-SIM operation that is fully supported in Windows 10. DSSA allows for
two SIM cards to be used with the modem, with the restriction that only one SIM can be active at any given time.

For more information, go to the Dual SIM Single Active page from Microsoft.

24 Setting Up the Windows 10 Operating System


https://support.microsoft.com/en-us/windows/cellular-settings-in-windows-905568ff-7f31-3013-efc7-3f396ac92cd7
https://learn.microsoft.com/en-us/windows-hardware/drivers/network/mb-multi-sim-operations#dual-sim-single-active

Accessing GPS

Go to the Windows location service and privacy page from Microsoft for information about accessing the GPS and for various
Windows settings.

Use the Unified Write Filter

Prerequisites
UWEF is installed.

About this task
The Unified Write Filter (UWF) is an optional Windows 10 feature.

For detailed information, see Use the Unified Write Filter (UWF) feature from Microsoft.

Steps

1. Configure UWF. The first time you enable UWF on your device, UWF makes the following changes to your system to improve
the performance of UWF:

Paging files are disabled.

System restore is disabled.

SuperFetch (also known as SysMain service) is disabled.

File indexing service is turned off.

Fast boot is disabled.

Defragmentation service (also known as Optimize drives service) is turned off.

BCD setting bootstatuspolicy is set to ignoreallfailures.

2. To enable UWF on a running device, perform the following steps:

a. Click Start, then type Turn Windows features on or off.

b. In the Windows Features window, expand the Device Lockdown node, and check Unified Write Filter > OK. There
will be a notification for necessary restart.
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https://support.microsoft.com/en-us/windows/windows-location-service-and-privacy-3a8eee0a-5b0b-dc07-eede-2a5ca1c49088
https://learn.microsoft.com/en-us/windows-hardware/customize/enterprise/uwf-turnonuwf

1T [ > Control Panel » Programs > Programs and Features

Control Panel Home . .
Uninstall or change a program

Loingialled uodaies To uninstall @ program, select it from the list and then click Uninstall, Chan
Turn Windows features on or ; |
A4 off [F4 Windows Features = O X
Turn Windows features on or off @]

To turn a feature on, select its check box. To tum a feature off, clear its |
check box. A filled box means that only part of the feature is tumed on.

[  Container Image Manager A
[C]  Containers
[J  Data Center Bridging
(W]  Device Lockdown
] | Custom Logon
[ | Keyboard Filter
[J | Shell Launcher

Unified Write Filter
C
5 [ Hyper-V

A Internet Fxnlarer 11

Figure 21. UWF in Windows Features

¢c. There will be a notification for reboot, click Restart Now.
3. To enable the filter, use the Windows Command Prompt: uwfmgr filter enable

Administrator: Command Prompt

Microsoft Windows [Version 16.0. l
(c) 2018 Microsoft Corporation.

C:\Windows\system32>uwfmgr filter enable
Unified Write Filter Contiguration UT1lity version 10.0.17763
Copyright (C) Microsoft Corporation. All rights reserved.

Unified Write Filter will be enabled after system restart.

Figure 22. UWF enable

4. To enable write protection for a drive, use the Windows Command Prompt: uwfmgr.exe volume protect C:

ES Administrator: Command Prompt

em32buwfmgr. volume p
Filtpr‘ ConT1 Util

The volume C: will be protected by Unified Writ

C:\Windows\system32>

Figure 23. UWF volume protect
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B. Restart the computer.
6. To confirm that UWF is running, use the Windows Command Prompt: uwfmgr.exe get-config

B Administrator: Command Prompt

aeadéd [C:]

of-b101

Figure 24. UWF get config

BMC firmware update procedure

Steps
1. Confirm that the Intel Serial IO - 12C and GPIO drivers are installed.

If the 12C driver is not installed, there will be a yellow triangle with an exclamation point over the menu icon in System
devices > Resource Hub proxy device in the Device Manager.
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File Action View Help

= =B

L -]

28

= Intel(R) GNA - 4511
3 Intel(R) Integrated Sensor Selution
= Intel(R) Management Engine Interface #1

3 Intel(R) PCI Express Root Port £0 - 4838 &4 Administrator: Command Prompt
32 Intel(R) PCI Express Root Port #2 - 4B3A
i3 Intel(R) PCI Express Root Port £6 - 4B3E
= Intel(R) PMC SRAM - 4B7F
i3 Intel(R) Power Engine Plug-in
K3 Intel(R) Serial IO GPIO Hest Controller - INTC1020
=2 Intel(R) Serial I0 GPIO Host Controller - INTC1020
3 Intel(R) Serial 10 GPIO Hest Controller - INTC1020
i Intel(R) Serial 10 GPIO Host Controller - INTC1020
3 Intel(R) Serial I0 GPIO Host Controller - INTC1020
= Intel(R) Serial IO 12C Host Controller - 4848
i3 Intel(R) Serial 10 12C Host Controller - 4878
= Intel(R) Serial IO 12C Host Controller - 4879
3 Intel(R) Serial I0 12C Host Controller - 4874
3 Intel(R) Serial 10 12C Host Controller - 48B3
= Intel(R) Serial 10 UART Host Controller - 4828
3 Intel(R) Serial IO UART Host Controller - 484D
= Intel(R) SMBus Controller - 4823
3 Intel(R) SPI (flash) Controller - 4824
= Microsoft ACPI-Compliant System
= Microsoft Hyper-V Virtualization Infrastructure Driver
= Microsoft System Management BIOS Driver
= Microsoft UEFI-Compliant System
= Microsoft Virtual Drive Enumerator
= Microsoft Windows Management Interface for ACPI
i3 Microsoft Windows Management Interface for ACPI
= Microsoft Windows Management Interface for ACPI
2 NDIS Virtual Network Adapter Enumerator
i PCI Express Root Complex
i3 PCl standard host CPU bridge
= Plug and Play Software Device Enumerator
= Programmable interrupt controller
3 Remote Desktop Device Redirector Bus

[ B Resource Fub proxy device ]
T Supel0 Driver
= System timer
2 UMBus Reot Bus Enumerator

§ Universal Serial Bus controllers

c-fuupd

Figure 25. 12C controller not found

If this is the case, perform the following steps:
a. Download both drivers from the EGW-3200 page of the Dell Technologies Support Site.

b. Install the drivers. When all the required drivers are installed, there is no yellow triangle with an exclamation point over

the icon in the device manager.
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https://www.dell.com/support/home/en-us/product-support/product/dell-edge-gateway-3200/overview

o
File Action View Help

e DB HE 2 EX®

i1 Intel(R) Power Engine Plug-in
i3 Intel(R) Serial 10 GPIO Hast Controller - INTC1020
3 Intel(R) Serial 10 GPIO Hest Controller - INTC1020
i Intel(R) Serial 10 GPIO Hast Controller - INTC1020
i Intel(R) Serial 10 GPIO Host Controller - INTC1020
i Intel(R) Serial 10 GPIO Host Controller - INTC1020
i3 Intel(R) Serial 10 12C Host Controller - 4BAB
i Intel(R) Serial 10 12C Host Controller - 4878
i3 Intel(R) Serial 10 12C Host Controller - 4879
K3 Intel(R) Serial 10 12C Host Controller - 4874
¥ Intel(R) Serial 10 12C Host Controller - 4878
3 Intel(R) Serial 10 12C Host Controller - 48B3
i3 Intel(R) Serial 10 12C Host Contraller - 48C0
i3 Intel(R) Serial 10 UART Host Controller - 4823
i1 Intel(R) Serial 10 UART Host Controller - 484D
i Intel(R) SMBus Controller - 4823
i Intel(R) SP (flash) Controller - 4624
= Microsoft ACPI-Compliant System
3 Microsoft Hyper-V Virtualization Infrastructure Driver
= Microsoft System Management BIOS Driver
i3 Microsoft UEFI-Compliant System
=1 Microsoft Virtual Drive Enumerator
i3 Microsoft Windows Management Interface for ACPI
= Microsoft Windows Management Interface for ACPI
= Microsoft Windows Management Interface for ACPI
i1 NDIS Virtual Network Adapter Enumerator
i1 PCI Express Root Complex
i PCl standard host CPU bridge
i1 Plug and Play Software Device Enumerator
3 Programmable interrupt contreller
1 Remote Desktop Device Redirector Bus
i1 Resource Hub proxy device
i1 SuperlO Driver
i System timer
=1 UMBus Root Bus Enumerstor
~ § Universal Serial Bus controllers
Generic SuperSpeed USB Hub
Generic USE Hub
Intel(R) USE 3.10 eXtensible Host Controller - 1.20 (Microsoft)
USE Composite Device
USB Mass Storage Device
USE Root Hub (USB 3.0)

Figure 26. Drivers installed

BN Administrator: Command Prompt

s\Administ
Lite BMC

fuupd -d -
upd -d -f filename.

et device or module
file

¢. When prompted, reboot the system.

A
File Action View Help
% @EHE P EXE

=1 Intel(R) Ethernet PCS - 1033

i Intel(R) GNA - 4511

31 Intel(R) Integrated Sensor Solution

3 Intel(R) Management Engine Interface #1

E=1 Intel(R) PCI Express Root Port £0 - 4838

3 Intel(R) PC Express Root Port #2 - 4B3A

¥ Intel(R) PCI Express Root Port #6 - 4B3E

3 Intel(R) PMC SRAM - 4B7F

i1 Intel(R) Power Engine Plug-in

=1 Intel(R) Serial 10 GPIO Host Controller - INTC1020
i Intel(R) Serial 10 GPIO Host Controller - INTC1020
i1 Intel(R) Serial 10 GPIO Host Controller - INTC1020
i Intel(R) Serial 10 GPIO Host Controller - INTC1020
=1 Intel(R) Serial 10 GPIO Host Controller - INTC1020
3 Intel(R) Serial 10 12C Host Controller - 4848

=1 Intel(R) Serial 10 12C Host Controller - 4878

i Intel(R) Serial 10 12C Host Controller - 4879

¥ Intel(R) Serial 10 12C Host Contraller - 4874

3 Intel(R) Serial 10 12C Host Controller - 4878

i Intel(R) Serial 10 12C Host Controller - 489

i1 Intel(R) Serial 10 12C Host Controller - 48C0

i1 Intel(R) Serial 10 UART Host Controller - 4828

¥ Intel(R) Serial 10 UART Host Controller - 484D

{3 Intel(R) SMBus Controller - 4823

E=1 Intel(R) SPI (flash) Controller - 4824

i Microsoft ACPI-Compliant System

1 Microsoft Hyper-V Virtualization Infrastructure Driver
i Microsoft System Management BIOS Driver

= Microsoft UEFI-Compliant System

i3 Microsoft Virtual Drive Enumerator

= Microsoft Windows Management Interface for ACPI
=8 Microsoft Windows Management Interface for ACPI
= Microsoft Windows Management Interface for ACPI
i1 NDIS Virtual Network Adapter Enumerator

¥ PCI Express Root Complex

i PCl standard host CPU bridge

i1 Plug and Play Software Device Enumerator

= Programmable interrupt controller

i1 Remote Desktop Device Redirector Bus

i3 Resource Hub proxy device

i3 SuperlO Driver

= System timer

Figure 27. Reboot system

2. Execute ad-litbmc-fwupd.exe in

Em Administrator: Command Prompt -

E 1 -d -t
d-1litbmc-fwupd -d -f filename.bin

ule

-litbmc-fwupd.

wupd.exe -u en

of publ.

e version on target de

command prompt to show usage of the tool.
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me.bin Publi
_1ith

Figure 28. Show usage

3. Update the firmware version by using the ad-litbmc-fwupd.exe -u <firmware> <public key> command. After the update,
a message shows that it is mandatory to reboot the system for changes to take affect. The tool also prints this message.

Figure 29. Reboot message

Reading the firmware version without rebooting will not show the updated version.

Figure 30. Updated version not shown

4, Reboot the device.
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Figure 31. Reboot device

B. After the reboot is complete, read the firmware version to confirm that it shows in the output.

Figure 32. Update successful

Accessing and updating the BIOS

Basic Input/Output System (BIOS) is a program that provides a basic level of communication between the processor and
peripherals. In addition, the BIOS also contains codes for various advanced features applied to the EGW-3200. The BIOS setup
program includes menus for configuring settings and enabling features of the EGW-3200. Most users do not need to use the
BIOS setup program, as the EGW-3200 ships with default settings that work well for most configurations.

Access the BIOS settings

Steps

1. Enter the BIOS setup by pressing the Delete key on the keyboard when the system is powered on. The POST (Power On
Self Test) message is displayed.

®| NOTE: The EGW-3200 controller supports a one-time boot menu allowing the selection of the boot device.

2. Enter the Boot Menu by selecting F7 at POST.

Update the BIOS using UEFI capsule update from Windows

About this task

The EGW-3200 supports UEFI capsule updates and can be updated natively within the Windows OS.
®| NOTE: Windows allows updating of the BIOS only if it is a newer version of the BIOS than what is already on the system.

The BIOS version number is available from the BIOS Main tab.
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Aptio Setup - AMI

Figure 33. BIOS version number under Main tab

Steps

1. Download the newer version of the BIOS in .msi format from the Dell Technologies Support Site and run the executable from
an elevated command prompt with administrator privileges.
Windows prompts to restart the system for a firmware change.

T Bl Wi 4

Wou nreust restast your computer 1o apply these
changes

Befioer restarting, save ary open fikes snd close 8 program.

Restan Lutes

Figure 34. Restart computer

2. Click Restart Now to restart the system.
The system will start the BIOS firmware update process.

Please wait while we instal n update

Press <DEL> or c Setup, <F to Enter Boot Henu

Figure 35. System update progress bar

Results

After the update is complete, the BIOS screen will show the newer version details.

SuperlO Function Library

This section describes use of the SuperlO (SIO) function library for the EGW-3200. The SIO function library includes the
watchdog timer function and the hardware monitor function. The watchdog timer is a hardware mechanism provided to reset
the system if the operating system or an application stalls. After starting, the watchdog timer in the application must be
periodically reset before the timer expires. Once the watchdog timer expires, a hardware-generated signal is sent to reset the
system. The hardware monitor is a mechanism provided to collect the wide range of information related to hardware health,
including CPU temperature, board temperature, and various voltage values.
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Windows SIO API

The SIO API library files and a demo program (including source code) are part of the board support package for the EGW-3200
(BSP/Sample_App_Source/SuperlO) and can be downloaded from the Dell Technologies Support Site.

SIO_WDT_Set

Sets the timeout value of the watchdog timer. SIO_WDT_Stop should be called before the expiration of watchdog timer, or the
system will reset.

132 SIO_WDT_Set (unsigned char val, int mode)

Parameters val—Specifies the value for the watchdog timer. A valid value is 1 - 255.

mode—Specifies the mode of the timeout value. The valid mode of the timeout value is seconds (0) or
minutes (1).

Return codes 0 if timeout value of watchdog timer is successfully set.

Negative error if timeout value of watchdog timer is failed to set.

SIO_WDT_GetCurrentTime
Gets the current timeout value of the watchdog timer, gives remaining watchdog timer timeout value and mode.
132 SIO_WDT_GetCurrentTime (unsigned char* pTime, int* mode)

Parameters pTIme—Pointer variable to return the remaining watchdog time for expiry.

Mode—Pointer variable to return the current watchdog mode.

Return codes 0 if timeout value of watchdog timer is available.

Negative error if failed to get the current timeout value and mode of the watchdog timer.

SIO_WDT_Stop

Stops the watchdog timer.

132 SIO_WDT_Stop ()

Parameters None
Return codes 0 if watchdog timer is successfully stopped.

Negative error if watchdog timer fails to stop.

GetCurrentCPUTemp

Gets the hardware monitor values.
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132 GetCurrentCPUTemp (int *temp)

Parameters temp—Integer pointer for getting the CPU temperature.

Return codes O if temperature is read successfully.

Negative error if failed to get the data from hardware monitor.

Error codes

For the various functions previously listed, the following is the error values in case of failure.

enum SIO ERRORS LIST{
ERROR_SIO INVALID DEVICE HANDLE = -100,
ERROR_SIO IOCTL,
ERROR_SIO_INVALID RW_SEL,
ERROR_SIO INVALID MODE SEL,
ERROR_SIO WDT NOT ENABLED

Build the SIO sample application

Prerequisites

Visual Studio 2019 is required for this task. To download and install, perform the following steps:

S IFNENINIE

Select Workloads.

Open Visual Studio Installer and click Modify to customize your installation.
Select Desktop development with C++ workload.

Select UWP.

Select Individual components, and under Complier, build tools, and runtimes, make sure that the following boxes are
checked:

a. MSVC v142 -VS 2019 C++ x64/x86 buildtools (latest) is checked.

b. MSVC v142 -VS 2019 C++ x64/x86 Spectre-mitigated libs (latest) is checked.

Make sure the SDK is installed. Download and install the corresponding WDK version.

Install the latest supported English (en-us) Microsoft Visual C++ redistributable packages for Visual Studio 2015, 2017, 2019,
and 2022 from the following link: VC_redist.x64.exe.

About this task
@ NOTE: The sample executable binaries are built with SDK-10.0.19041.685 and WDK-10.0.19041.685 versions. The procedure

may vary slightly if using other versions.

To build the sample application, perform the following steps.

Steps

1.

2
3

Open Sample_App_Source/SuperlO/superior_nct.sIn in Visual Studio.

. Change Solution configuration to Release and Solution platform to x64.
. Under the Build menu, select Build Solution.

Execute the SIO sample application

About this task

The EGW-3200 Windows image includes pre-installed sample application binaries.

Steps

1.

Open the command prompt in administrator mode.
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2. Change to the following directory: C: \Program Files\Dell\EGW3200 Software tools\Application
Binaries

3. Use the following commands to execute the SIO sample application:
a. To set the watchdog timer:

> superiotest wdtset <time> <mode>

Where time is between 1 to 255, and mode is seconds or minutes.

b. To stop the watchdog timer:

> superiotest wdtstop

c. To get the remaining watchdog time and mode:

> superiotest wdtgettime

d. To get CPU temperature:

> superiotest getcputemp

Digital Input/Output Function of the Intel PCH
Controller

The EGW-3200 uses Microsoft's RHProxy interface for accessing the GPIO pins from PCH chipset. All the necessary changes
are done in the BIOS. For a sample program, the GpioTestTool source code from the Microsoft GitHub can be used.

The EGW-3200 has six DI pins, six DO pins, and three user LEDs. For the pin details and pin numbers to be used for the sample
application, refer the table in RHProxy driver - 12C and GPIO.

Build the GPIO sample application

Prerequisites
Visual Studio 2019 is required for this task. Do download and install, perform the following steps:

Select Workloads.

Open Visual Studio Installer and click Modify to customize your installation.

Select Desktop development with C++ workload.

Select UWP.

Select Individual components, and under Complier, build tools, and runtimes, make sure that the following boxes are
checked:

a. MSVC v142 -VS 2019 C++ x64/x86 buildtools (latest) is checked.

b. MSVC v142 -VS 2019 C++ x64/x86 Spectre-mitigated libs (latest) is checked.

6. Make sure the SDK is installed. Download and install the corresponding WDK version.

7. Install the latest supported English (en-us) Microsoft Visual C++ redistributable packages for Visual Studio 2015, 2017, 2019,
and 2022 from the following link: VC_redist.x64.exe.

S IFNESNNIES

About this task

@ NOTE: The sample executable binaries are built with SDK-10.0.19041.685 and WDK-10.0.19041.685 versions. The procedure
may vary slightly if using other versions.

To build the sample application, perform the following steps.

Steps
1. Open Sample_App_Source/GPIOTestTool/windows-iot-bus-tools.sIn in Visual Studio.
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2. Change Solution configuration to Release and Solution platform to x64.
3. Under the Build menu, select Build Solution.

Execute the GPIO sample application

About this task

The EGW-3200 Windows image includes pre-installed sample application binaries.

Steps
1. Open the command prompt in administrator mode.

2. Change to the following directory: C: \Program Files\Dell\EGW3200 Software tools\Application
Binaries

3. Use the following commands to execute the GPIO sample application:
a. To open the pin connection:

> GpioTestTool.exe <pin>

b. To set the drive mode to output:

> setdrivemode output

c. To set the DOO pin to low:

> write O

d. To set the DOO pin to high:
> write 1

Similarly, the pin can be opened and set to drive mode input and the current value can be read using a read command.
Use the help command for detailed usage.

Digital Input/Output Function from PCA9535 GPIO

Users can opt to connect a PCA9535 GPIO expander module to one of the 12C buses of the EGW-3200.

PCA9535 GPIO Expander API

The PCA9535 GPIO module’s API library files and a demo program (including source code) are included in the board support
package for the EGW-3200.

PCA9535Init

This function is used to initialize the directions of the GPIO pins. Also, it opens the handle to the I2C bus and it is necessary to
call this function before executing any of the other APls.

int PCA9535Init (unsigned int i2cnumber)

Parameters i2cnumber—The 12C bus number to which the PCA9535 board is connected. Can be O or 1.
Return codes 0 if the initialization is successful.

Negative error if failed.
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DioSetLevel

Sets the GPIO level for output pins.

int DioSetLevel (unsigned char data, unsigned char mask)

Parameters data—The new GPIO level to be set for the output pins.

mask—GPIO output pins are changed only for those corresponding to the bits that are set to 1in the
mask. Other pin values remain unchanged.

Return codes 0 if the initialization is successful.

Negative error if failed.

DioGetLevel

Gets the current GPIO level for both input and output pins.

int DioGetLevel (unsigned int mask, unsigned int* GetPinLevel)

Parameters mask—The GPIO input pins are updated in the GetPinLevel only for the bits which are set to 1in the
mask.

GetPinLevel—Pointer to store the read value. The first eight bits (Bit O to 7) contain the GPIO input
pin’s voltage level. The second eight bits (Bit 8 to 15) contain the GPIO output pin’s voltage level.

Return codes 0 if the initialization is successful.

Negative error if failed.

Error codes

For the various functions previously listed, the following is the error values in case of failure.

enum errorcodes
Error Pointer Invalid = -100,
Error I2C controller NotFound,
Error I2C Open Failed,
Error I2C Bus Invalid,
Error Mutex Failed,
Error I2CTransfer Partial,
Error I2CTransfer SlaveAddressNotAcknowledged,
Error I2CTransfer ClockStretchTimeout,
Error I2CTransfer UnknownError

Build the PCA9535 sample application

Prerequisites
Visual Studio 2019 is required for this task. Do download and install, perform the following steps:

Select Workloads.

Open Visual Studio Installer and click Modify to customize your installation.
Select Desktop development with C++ workload.

Select UWP.

Noop 2
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B. Select Individual components, and under Complier, build tools, and runtimes, make sure that the following boxes are
checked:

a. MSVC v142 -VS 2019 C++ x64/x86 buildtools (latest) is checked.
b. MSVC v142 -VS 2019 C++ x64/x86 Spectre-mitigated libs (latest) is checked.
6. Make sure the SDK is installed. Download and install the corresponding WDK version.

7. Install the latest supported English (en-us) Microsoft Visual C++ redistributable packages for Visual Studio 2015, 2017, 2019,
and 2022 from the following link: VC_redist.x64.exe.

About this task

@ NOTE: The sample executable binaries are built with SDK-10.0.19041.685 and WDK-10.0.19041.685 versions. The procedure
may vary slightly if using other versions.

To build the sample application, perform the following steps.

Steps

1. Open Sample_App_Source/PCA9535/PCA9535_12C.sIn in Visual Studio.
2. Change Solution configuration to Release and Solution platform to x64.
3. Under the Build menu, select Build Solution.

Execute the PCA9535 sample application

About this task

The EGW-3200 Windows image includes pre-installed sample application binaries.

Steps
1. Open the command prompt in administrator mode.

2. Change to the following directory: C: \Program Files\Dell\EGW3200 Software tools\Application
Binaries

3. Use the following commands to execute the PCA9535 sample application:

a. Use the following command to execute the pca9535_interrupt.exe with two arguments (<l2c Number> and <GPIO
Number>):

> pca9535 interrupt.exe 0 8

b. Execute the pca9535App.exe for write functionality:
Pca9535App.exe i2c <i2cnumber> write <write value in hex> <mask value in hex>

> pca9535App.exe i2c 0 write Oxff Oxff

<writes all output pins to high>
c. Execute the pca9535App.exe for read functionality:
pca9535App.exe i2¢ <i2cnumber> read <mask value in hex>

> Pca9535App.exe i2c 0 read Oxff

<reads all pins>

Hardware monitor API

The EGW-3200 has various hardware monitor features which can be retrieved by using the following function parameters.

EApiLiblnitialize

Initialize function. Call this function before accessing any of the API.
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int EApiLibinitialize ()

Parameters None
Return codes 0 if the initialization is a success.

Negative error if failed.

EApiBoardGetValue

Gets the hardware monitor (current/voltage/temperature) values.

int EApiBoardGetValue (int parameter)

Parameters The parameters could be one of the following, and the macro is self-explanatory.
e EAPI_ID_HWMON_SYSTEM_TEMP

EAPI_ID_HWMON_VOLTAGE_VBAT

EAPI_ID_HWMON_VOLTAGE_5VSB

EAPI_SEMA_ID_BOARD_MAIN_CURRENT

EAPI_SEMA_ID_HWMON_VOLTAGE_VIN

Return codes 0 if the initialization is a success.

Negative error if failed.

EApiUnlinitialize

Un-initialize function. Call this function before exiting the application.

Humidity and temperature sensor setup

Prerequisites

Windows standard APIls: FromldAsync(String), GetCurrentReading(), and GetDeviceSelector(Guid interfaceld) are used for
accessing the sensor. For details, go to the Windows.Devices.Sensors.Custom Namespace Microsoft page.

About this task

The HDC1010 humidity and temperature sensor is connected to 12C bus 2 of the EGW-3200. This sensor is detected as a
custom sensor and follows Windows sensor framework.

Build the sample application

Prerequisites
Visual Studio 2019 is required for this task. To download and install, perform the following steps:

Select Workloads.

Open Visual Studio Installer and click Modify to customize your installation.

Select Desktop development with C++ workload.

Select UWP.

Select Individual components, and under Complier, build tools, and runtimes, make sure that the following boxes are
checked:

a. MSVC v142 -VS 2019 C++ x64/x86 buildtools (latest) is checked.

b. MSVC v142 -VS 2019 C++ x64/x86 Spectre-mitigated libs (latest) is checked.

CIFSESENIES
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6. Make sure the SDK is installed. Download and install the corresponding WDK version.

7. Install the latest supported English (en-us) Microsoft Visual C++ redistributable packages for Visual Studio 2015, 2017, 2019,
and 2022 from the following link: VC_redist.x64.exe.

About this task

To build the sample application, perform the following steps.

Steps

1. Open the solution file of the source code in Visual Studio.

2. Change Solution configuration to Release and Solution platform to x64.

3. In the Solution Explorer pane, right-click on the project and select Properties.

ﬂ Accelerometer - Microsoft Visual Studio X &’ QuickLaunch (Ctrl+Q) p -

File Edit View Project Build Debug Team Tools Test Driver Analyze Window  Help 5

B-am Release ~ xG4 - P localMachine - 57 _: 93 A A - 3

w

o 4 Build i

B Rebuild

= Deploy

CE_" Clean !

g View 3
Analyze »
Project Only 3

Retarget Projects

Scope to This
Mew Solution Explorer View
¥ Show on Code Map
Build Dependencies 3
Add o
Class Wizard... Ctrl+Shift+X
Manage NuGet Packages...

o JN::

Set as StartUp Project 2
Debug 3

Ed

Cut Ctrl+X

Remove Del 1

A x

Rename

Unload Project

Rescan Solution

Display Browsing Database Errors
Clear Browsing Database Errors

Output @ Open Folder in File Explorer

[J Ready Lni Col 1 Chl T2 & Properties Alt+Enter I

Figure 36. Solution Explorer - Properties

4. Change the Target Platform Version and Target Platform Min. Version to 10.0.17763.0 and Platform Toolset to the
Visual Studio version used. Set the Configuration to Release and Platform to x64. Click Apply and OK.
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Accelerometer Property Pages ? =
Configuration:  Release ~ | Platform: | x64 ~ Configuration Manager...
4 Configuration Properties v General
General Target Platform Windows 10
Debugging Target Platform Version 10.0.17763.0
VC++ Directories Target Platform Min. Version 10.0.17763.0
b C/Ces Output Directory $(SolutionDinS(Platfarm)\S(Configuration)\S (MSBuildProjectName
b Linker Intermediate Directory $(Platform)\S(Configuration),
P CEni=iTire] Target Name $(ProjectName)
I XML Document Fﬁenerator Target Extension exe
b B“_ste ibpnatiy Extensions to Delete on Clean *.cdf*.cache™ obj:*.obj.enc™.ilk:*.ipdb;*.ichj:* resources;” tlh;* tli:*.t
E EE':OE:EB”E sseep Build Log File SUntDINS(MSBuildProjectName) Jog
b Code Analysis Visual Studio 2010 (v100) (not installed) v
v Project Defaults
Configuration Type Application (.exe)
Whole Program Optimization Use Link Time Code Generation
Windows Store App Support Yes
Platform Toolset
Specifies the toolset used for building the current configuration; If not set, the default toolset is used
£ >

Cancel

Figure 37. Properties - Platform Toolset

5. Select Build > Build Solution to build the project.

Eﬂl Accelerometer - Microsoft Visual Studio
File  Edit View  Project  Build = Debug

MR RN B

Team  Tools  Test  Driver

Build Solution

Analyze  Windov
Ctrl+5hift+B

x¥0qoo]  Jauio|dxg ;anag

Figure 38. Build Solution

Rebuild Solution

Deploy Solution

Clean Solution

Build full program database file for solution

Run Code Analysis on Solution Alt+F11

€

Build Accelerometer

Rebuild Accelerometer

Deploy Accelerometer

Clean Accelerometer

Run Code Analysis on Accelerometer

Project Only ]
Batch Build...

Configuration Manager...
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Create the MSIX package

Steps

1. Place the Assets folder in the current directory (Path: x64/Release/ilc/in).
2. Right-click on the project and Select Publish > Create App Packages.

3. Enable Side-loading in the first page of the wizard and then click Next.
4

On the Select signing method page, select whether to skip packaging signing or select a certificate for signing. For
an MSIX package to be installed, it must be signed with a certificate that is trusted on the machine. The certificate is
password-protected. It is imported to the certificate store for package signing.

Create App Packages ? x
Select signing method

‘Would you like to sign this app package?

() No, skip package signing.
App packages must be signed before they can be installed. You will have to sign the app packages externally.
How do | sign an app package?

(® Ves, select a certificate:

Select From Azure Key Vault... Select From Store... Select From File... Create...

€3 Choose a certificate to sign the app package.

Create a Self-Signed Test Certificate

Self-signed certificates are intended for testing and may prevent your app from installing on other
machines. We recommend using a trusted certificate when publishing your app.

Publisher Common Name
[Dell |

Enter password for new file CustomSensors_TemporaryKey.pfx

Confirm your password

|..oooc |

How do | create a pe

acel

Figure 39. Create Certificate
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Create App Packages

Select signing method

Would you like to sign this app package?
) No, skip package signing.
App packages must be signed before they can be installed. You will have to sign the app packages externally.
How do | sign an app package?
® Yes, use the current certificate:

Subject: CN=Dell
Thumbprint: AED1381E3B06CDIAGEA4CBIEED170DAEES2BBCES
Expiration Date: 11-10-2022 05:56:43

) This certificate is not trusted on this PC. 9 Trust
If you plan to install this app, import this certificate to the trusted certificate store.

This operation requires Administrator privileges.

Remove Details

Timestamp server URL (optional):

Encryption algorithm:

SHA256 -

How do | create a package signing certificate?

Previous Next Cancel

Figure 40. Certificate Trust

5. In Select and configure packages wizard, select the Architecture as x64 and Solution Configuration as Release
(x64) and click Next.
6. Provide the path for the Installer location (where the app is published) and select Create.

Results
The project builds and App bundle is created. The package summary appears.
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Create App Packages ? X

Finished creating package

Output location:

D:\work\Windows-universal-samples-main\Windows-universal-samples-main\Samples\HDC1010_App_Working\AppPackages
\CustomSensaorsh,

Installer location:

D:\waork\Windows-universal-samples-main\Windows-universal-samples-main\Samples\HDC1010_App_Working

Package summary:
Version: 1.0.0.0
Required Operating System: 10.0.17763.0

Architecture: x64
Bundle: Yes
Publisher: Microsoft Corporation

) Running the included sideloading PowerShell script will collect usage data on the device where it's run. For more details, including
instructions on how to disable data collection through the registry, please see here.

© To copy the created packages from the output location to the installer location, select “Copy and Close.”

Copy and Close Close

Figure 41. Finished creating package

Import the certificate

Steps

1. Unzip the folder Sensor Applications.7z containing the MSIX bundle.

2. Locate the certificate files for this application in folder HDC1010.

3. Go to Start > Manage computer certificates. On the left pane of the certim wizard, select Trusted People.
4. Select Action > All Tasks > Import. The Certificate Import Wizard appears. Click Next.
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ﬁ certlm - [Certificates - Local Computer\Trusted People] = O *

File Action View Help

= Find Certificates.. 5

S AlTasks > Find Certificates..
_ Refresh Import... ms to show in this view.
P Export List...
_ Help

| Untrusted Certificates

| Third-Party Root Certificat

| Trusted People

| Client Authentication Issue
- || Preview Build Roots

| Test Roots

| AAD Token Issuer

| eSIM Certification Authorit

| Homegroup Machine Cert
- | Local NonRemavable Certi
- ] Remote Desktop .

| Fartificatn Eneallonant Dan
< > < >

Add a certificate to a store

Figure 42. Import Certificate

5. Include the path where the certificate is located. Click Next.
6. The certificate is imported. Click Finish.
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“  L¥ Certificate Import Wizard

| Completing the Certificate Import Wizard

The certificate will be imported after you click Finish.

You have specified the following settings:

Certificate Store Selected by User JRETE sl Telel ]

Content Certificate

File Name D:\work\Windows-universal-samples-main\Windows-
< >

coce

Figure 43. Completing the Certificate Import Wizard

7. The imported certificate is added in the Certificates directory under Trusted People. If not, select Action > Refresh, and
the certificate is added.
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ﬁ certlm - [Certificates - Local Computer\Trusted People\Certificates] = O x

File Action View Help
s 2F 0/ 6z HE

;ﬁl Certificates - Local Computer » || |ssued To Issued By Ex

- Personal 51Dell Dell 1
| Trusted Root Certification .

] Enterprise Trust
| Intermediate Certification .
~| Trusted Publishers
| Untrusted Certificates
~| Third-Party Root Certificat
v [ Trusted People
| Certificates
| Client Authentication lssue
| Preview Build Roots
| Test Roots
| AAD Token Issuer
- ] eSIM Certification Authorit
] Homegroup Machine Cert
| Local NonRemovable Certi .

[ R O P P

< > < >

Trusted People store contains 1 certificate.

Figure 44. Certificates

Install the application

About this task

The example referred to in the following steps is for the HDC1010 humidity sensor application. The same steps are applicable for

other two sensors.

Steps

1. Install the App Installer from the Microsoft store. To do this, open the POWERSHELL in ADMINISTRATOR Mode and
execute the following command:

Get-AppXPackage*WindowsStore* -AllUsers| Foreach
{Add-AppxPackage-DisableDevelopmentMode-Register
"$($ .Installlocation) \AppXManifest.xml"}

2. Run the .msixbundle file. A window appears prompting to install the application. Click Install.
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Install HDC1010 C++ sample?
ﬁTrustedApp

Publisher: Microsoft Corporation
Version: 1.0.0.0

®

Figure 45. Install prompt

The application is installed and the UWP application appears.

3. Click Start.
The application name appears.

HOC10N0 C++ Sample

Microsoft Store

Search

Sethi i

Windows Acces
Windews Administrative Tools
findiows Ease o

Whintdorws PowerShell

| nghts reserved,

Figure 46. Application name in Start Menu
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Run the temperature sensor application

About this task

Two events are registered for the application: DatakEvents and Polling.

Steps
1. Select DataEvents > Enable. Temperature and Relative Humidity values are displayed.
2. Select DataEvents > Disable and follow Step 1 to obtain the next set of readings.

— Universal Windows Platform sample

Registers an event listener for Temperature and Humidity sensor data and displays the value as it is reported.

HDC1010 Humidity sensor

1) DataEvents

Enable Disable
Temperature (degree Celsius): 37.323

2) Polling Humidity (%) 52.4658

Figure 47. DataEvents

8. Select Polling and repeat Steps 1and 2.

— Universal Windows Platform sample

- Polls for sensor data and displays temperature and humidity
HDC1010 Humidity sensor

Get Temperature and Humidity

1) DataEvents 5 -
Temperature (degree Celsius) 37.4243

Humidity (%) 52,4658
2) Polling T N

Figure 48. Polling
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Pressure sensor setup

Prerequisites

Windows standard APIs: FromldAsync(String), GetCurrentReading(), GetDefault(), and GetDeviceSelector(Guid interfaceld) are
used for accessing the sensor. For details, go to the Windows.Devices.Sensors.Custom Namespace Microsoft page.

About this task

The DPS310 pressure sensor is connected to 12C bus 2 of the EGW-3200. This sensor is detected as a barometer sensor and
follows Windows sensor framework.

See the Humidity and temperature sensor setup section for the following tasks:

Build the sample application
Create the MSIX package
Import the certificate
Install the application

Run the pressure sensor application

About this task

Two events are registered for the application: DataEvents and Polling.

Steps

1. Select DataEvents > Enable. The Pressure value is displayed in hectopascals.
2. Select DataEvents > Disable and follow Step 1 to obtain the next set of readings.

Barometer C++ Sample
Universal Windows Platform sample

Registers an event listener for barometer data and displays the pressure in hPa values as they are reported.

Barometer

Disable

1) Data Events
hPa: 898.861

2) Polling

Figure 49. DataEvents

8. Select Polling > Get Data and repeat Steps 1and 2.

Barometer C++ Sample
Universal Windows Platform sample

Polls for barometer data and displays the pressure in hPa values.

Barometer
Get Data

1) Data Events
hPa: 898.874

2) Polling

Figure 50. Polling
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Accelerometer sensor setup

Prerequisites

Windows standard APIs: FromldAsync(String), GetCurrentReading(), GetDefault(), and GetDeviceSelector(Guid interfaceld) are
used for accessing the sensor. For details, go to the Windows.Devices.Sensors.Custom Namespace Microsoft page.

About this task

The ADXL345 accelerometer sensor is connected to 12C bus 2 of the EGW-3200. This sensor is detected as a accelerometer

sensor and follows Windows sensor framework.

See the Humidity and temperature sensor setup section for the following tasks:

Build the sample application
Create the MSIX package
Import the certificate
Install the application

Run the accelerometer sensor application

Steps

1. Choose accelerometer: Click the Standard type of accelerometer.

Accelerometer C++ Sample

Universal Windows Platform sample

Accelerometer C#
Sample

1) Choose accelerometer
2) Data Events

3) Shake Events

4) Polling

5) OrientationChanged

&) Data Events Batching

Figure 51. Choose accelerometer

Description:

Choose accelerometer

Choose the accelerometer to be used by the other scenarios.
Standard
Linear

Gravity

2. Data Events: Click Enable. The corresponding x, y, and z values are displayed as you change the position of the sensor.
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Accelerometer C++ Sample - m] x

Universal Windows Platform sample

Accelerometer C# Description:
Sa rﬂple Data events

Registers an event listener for accelerometer data and displays the X, Y and Z acceleration values as they are
1) Choose accelerometer reported.

2) Data Events Disable

X:0.0859375, Y: -0.167969, Z: -0.925731
3) Shake Events
4) Polling

5) OrientationChanged

6) Data Events Batching

Figure 52. Data Events

3. Polling: Click Enable. Acceleration values at a particular time interval are displayed.

Accelerometer C++ Sample - O X

Universal Windows Platform sample

Accelerometer C# Description:
Sample Polling

Polls for accelerometer data and displays the X, Y and Z acceleration values at a set interval.

1) Choose accelerometer ~
Disable

o .
2 RE B X: 0.03125, : -0.308594, 7: -0.917969
3) Shake Events

4) Polling

5) OrientationChanged

6) Data Events Batching

Figure 53. Polling

4. OrientationChanged: Click Enable to display the accelerometer readings with and without the transformation.

Accelerometer C++ Sample — [m] X

Universal Windows Platform sample

Accelerometer C# Description:
Sa I"ﬂpl e Orientation change

Registers for OrientationChanged event of the Displaylnformation class to illustrate the usage of the
1) Choose accelerometer ‘ReadingTransform’ Property. Displays accelerometer readings with and without the transformation.

2) Data Events e Disable

Untransformed:
3) Shake Events
X:-0.0820313, Y: -0.195313, Z: -0.941406

4) Polling Transformed to DisplayOrientation:

5) OrientationChanged X:0.195313, Y: -0.0820313, Z: -0.941406

€) Data Events Batching

Figure 54. OrientationChanged
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Intel OOB

Out-of-Band (OOB) is the service that is performed if the processor platform runs on the ARM Cortex-M7 processor that is
independent of the system’s main CPU complex and host OS. The OOB service is enabled through PSE and allows users to
execute cloud-initiated commands such as reboot, shutdown, and powerup, and to decommission device operations using the
scalable device management clouds as the Azure IOT central cloud.

Table 5. Hardware requirements

Device

Specification

Linux OS (development machine)

Ubuntu OS version 18.04 LTS installed with display monitor, keyboard, and mouse

Edge Gateway 3200 (target board)

Windows 10 OS installed with display monitor, keyboard, and mouse

Other hardware

A router with ethernet LAN cable (wired)

Host and target setup

Host setup

The development machine (host) should have the Linux Ubuntu OS (version 18.04 LTS and above) installed.

®| NOTE: We have used Ubuntu version 20.04 LTS.

Target setup

The Dell Edge Gateway 3200 with the Elkhart Lake Platform and with Windows 10 Enterprise LTSC 2019 installed.

Perform changes in the BIOS

Steps

1. At the BIOS menu, select Chipset > PCH-10 Configuration > PSE Configuration > OOB [Enabled].
2. Set this OOB to be Enabled. OOB provisioning will fail in OOB service provisioning if this is not set to Enabled.
3. At the BIOS menu, select Chipset > PCH-10 Configuration > PSE Configuration > GBEO [PSE owned with pin

muxed].
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Aptio Setup - AMI

Enables/Disables
Programmable Service
Engine (PSE) Device

00B Manageability
State

00B Prowvision
00B Cloud Type
00B Cloud URL
00B Cloud Port

SFEiSellecisSeReEn

Tl: Select Item
[Enabled] Epterassailect
[Enabled] +/— " Chanzef Ut

[Host owned with pin F1: General Help
muxed] F8: Previous Values
[PSE owned with pin F9: Optimized Defaults
muxed] F10: Save & Exit

ESGh BNt

version 2.21.1278 Copyright (C) 2021 AMI

Figure 55. Configure OOB enabled

4. Press the Esc button to return to the main menu. When prompted with Save Changes and exit?, press Y to save the
settings.

5. Perform a hard reset by turning the power off and on again. This is necessary when changing a PSE-related setting.
6. Connect an Ethernet cable to PSE GbEO.

Results

You have now set up hardware network connectivity on the target board, which is now ready to connect with the Cloud Service
Provider (CSP), as detailed in the following sections.

Cloud setup and configuration

About this task

The cloud adapter module maps specific cloud functions based on the cloud service provider and implements specific cloud
customizations such as Message Queuing Telemetry Transport (MQTT) topics and message formats.

Set up Azure loT Central for device management

About this task

Intel provides the connectivity reference implementation for the Microsoft Azure device management solution.

Steps

1. Create an Azure account and an Azure loT Central application for the device to connect to its intended portal customers.
Refer to the instructions on the Azure website to create an Azure account.
2. Create an IoT Central application by importing the reference template from the Azure loT Central site.

3. Create a template application name and URL, then click Create to create an loT central application template.
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https://azure.microsoft.com/en-us/free/
https://azure.microsoft.com/en-us/services/iot-central/#overview

@ Azure loT Central

Build > New application

@  Home Intel X6000e Out-of-band Management

I ffl Build Intel X6000e (Elkhart Lake) Qut-of-band Management

B My apps About your app

Application name * @®

‘ EHL_EGW3200) x

URL* @

ehl-egw3200 .azureiotcentral.com

Pricing plan

O Free
Try for 7 days with no commitment

5 free devices

(O Standard 0
For devices sending a few messages per day

2 free devices 400 messages/mo

O Standard 1
For devices sending a few messages per hour

2 free devices 5,000 messages/mo

(®) Standard 2 (most popular)
For devices sending messages every few minutes

DV fran Adasrieac AN NANN rrncesmae frne

Figure 56. Azure loT central application template

4. After creating the Azure portal and template, add a new device. Click the Devices tab, select the Intel template, and then
click the + symbol to create a real device.
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Create a new device X

To create a new device, select a device template, a name, and a unique ID. Learn more &=

Device name * (i)

EHL_EGW3200

Device ID * (D)

Trmztmd4rixd

Organization * ()

Test_oob

Device template *

ntel-x6000e-out-of-band v3 7

Simulate this device?
A simulated device generates telemetry that enables you to test the behavior of your application before
you connect a real device.

@ v

Figure 57. Create a new device

B. Copy the connectivity credentials for the device to connect back to the portal. Copy the connection credentials by clicking
the Connect button. The following screen appears.
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Device connection

ID scope @

. =y
Device ID L/

new-device m

Credentials

Shared access signature (SAS)  Certificates (X.509)

SAS security tokens are an attestation mechanism for devices to connect to loT Central. The group SAS
keys for this device are shown below. Use them to register your device with loT Central. Click to learn

more, =

Primary key @

Secondary key ©

Close

Figure 58. Device connection

6. Keep a copy of the following data. Use these data to create credentials for the target device to connect to the portal
over the MQTT protocol. Intel provides a sample script that gives the credentials by invoking the Azure loT Hub Device
Provisioning Service (DPS).

e |D scope
e Device ID
e Primary key

Create an OOB capsule binary

About this task

In this task, the user generates the OOB credentials capsule binary in the host machine.

Steps
1. Prepare the OOB credentials capsule from the host machine.
2. Get the Intel Programmable Service Engine SDK source code.

3. Download the Firmware and BIOS Ultilities (FBU), which is the configuration tool for provisioning data into BIOS subregions.

The latest open-source FBU release package can be downloaded from the iotg-fbu page at the GitHub software
development platform.
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10.
1.

Copy all files from the pse-dev-code-base/tools/capsule_script folder to the scripts folder of the FBU tool. This ensures
that you have all of the files needed to generate the MAC and OOB credentials capsules in the correct location:

cp ~/intelpse/pse sdk/code/pse-dev-code-base/tools/capsule scripts/* ~/intelpse/fbu/
siiptool/scripts/

Go to the scripts folder of the FBU tool:

cd ~/intelpse/fbu/siiptool/scripts

Confirm that the files were added to the scripts folder, as shown in the following figure.

AT e

= |: ~/1ntelpseffbuf'511ptool/Scrlptsfﬁ 1s -la

total 140

drwxrwxr-x
drwxrwxr-x
—“IWEIWEI—X
-Ir'w-rw-r—-—
—“IWEIWEI—X
drwxrwxr-x
—“IWEIWEI—X
-I'W-IW-I——
—-rW-rw-r—-—
-I'W-IW-I——
~IWEIrWXIr—X
—“I'WELWXI—X
—-rW-rw-r—-—
-I'W-IW-I——

iotg iotg 4086 Jan 13 11:35

iotg iotg 4096 Aug 27 22:43

iotg iotg 4746 Jan 13 11:35

iotg iotg 1282 Jan 13 11:35 azure

iotg iotg 26666 Jan 13 11:3@
iotg iotg 4096 RAug 28 23:57 Example

iotg iotg 4445 Jan 13 11:35

iotg iotg 1171 Jan 13 11:3

iotg iotg 1732 Jan 13 11:35 OOBCapsule template.json
iotg iotg 33538 Aug 27 22:43 siip sign.py

iotg iotg 12175 Rug 27 22:43

iotg iotg 5927 Aug 27 22:43

iotg iotg 9835 Rug 27 22:43 subregion sign.py

iotg iotg 1250 Jan 13 11:35 telit.pem

[ R e e - B B S Sy B

Figure 59. Capsule script file

Run the user script using the following commands:

chmod +x capsule json script.sh

Launch the script according to your cloud certificate:

./capsule json script.sh azure.pem
®| NOTE: azure.pemis the cloud certificate.

The script will prompt for the following user inputs:

Select Capsule Type: Type 1 for OOB.

Enter Capsule file name: Type a £ilename for the capsule binary, for example “OobCapsule”.

Select Cloud Provider: Type 2 for Azure.

Enter Scope ID: Provide the scope ID copied in the previous task, Set up Azure loT Central for device management.
Enter Device ID: Provide the device ID copied in the previous task, Set up Azure loT Central for device management.

Enter Primary Key: Provide the primary key copied in the previous task, Set up Azure loT Central for device
management.

-0 Q0 Do

g. Enter Proxy (SOCKS5) IP: Enter the proxy address of your organization. Press Enter for a blank field entry if there is

no proxy address.
At completion, a JSON file (.json) and its capsule binary file (.bin) are created.
Copy the .bin file to the USB flash drive.

Results

The flash drive now includes the MAC capsule (Phy.zip) and OOB credentials capsule files.
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OOB service provisioning

About this task

In this task, the user connects the USB flash drive with the capsule files from the host machine, inserts the flash drive to a USB
port on the EGW-3200 target board, and updates the MAC capsule and OOB capsule binary files.

Update the MAC capsule

Steps
To update the MAC capsule, use the tool (Phy.zip) and update the MAC address under UEFI Shell.

1.

2.

Use CapsuleApp.efi to update the MAC capsule under UEFI Shell directly.

Usage: CapsuleApp.efi capsule.out.bin

Perform a hard reset by turning the power off and on after updating the MAC address.

Update the OOB credentials capsule

Steps

1.

To update the OOB capsule, use CapsuleApp.efi with capsule binary under UEFI Shell directly.

Usage: CapsuleApp.efi OobCapsule.bin

Perform a hard reset by turning the power off and on after updating the OOB capsule.

At the BIOS menu, select Chipset, as shown in the following figure.

Find the OOB Cloud Type, OOB Cloud URL, and OOB Cloud Port information. The OOB feature state and provisioning

state should be Enabled, as shown in the following figure.

APt io Setup - AMI

[Enabled]

[Enabled)

[Host ouwned with pin
mused)

Figure 60. BIOS menu

Activate OOB commands using Azure

Prerequisites

A device management cloud account is created and the EGW-3200 is successfully provisioned with the OOB credentials to

connect to the cloud.
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M| +/-: Change opt.

| |F1: General Help

+|FB: Previous Values
I|F2: Optimized Defaults

Fl10: save & Exit
ESC: Exit
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About this task

In this task, the user sends an OOB command from the Azure loT Central portal.

Steps
1. After provisioning and connecting the device to the Azure loT Central portal, the device status changes to provisioned.
2. Click on the device and then navigate to the following for more information:
a. Overview: To view the Device Properties.
EHL_EGW3200
= # Connect By Manage template @ Manage device
EeifEeass Devices > intel-x6000e-out-of-band v3 > EHL EGW3200
| @ oevices =  EHL_EGW3200
; °Ccnneced | Last data received: 11/26/2021, 3:25:33 PM | Status: Provisioned | Organization: EHL_EGW3200
L Device groups
Events View  Overview  Commands Raw data
%5 Rules
lc_¢ Analytics
Device Properties
% Jobs
Platform Architecture arm
APP seﬂings read only device property
Platform Board intel_ehl_rvp
@, Device templates read only device property
Cz Data expart Flatform 08 fazh:yr:ly device property
;& Administration Platform SoC Elkhart_Lake
read only device property
Figure 61. Overview
b. Commands: to send OOB power control commands to the device.
3. The OOB service, enabled through the PSE, allows the user to execute the following commands:
e Reboot: Reboots platform.
e Shutdown: Puts the platform in a low power state.
e Power Up: Brings the platform out of low power state.
e Decommission: Un-registers the platform, withdrawing the device from remote management using the cloud.
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Figure 62. Com

& Connect @, Manage template ¥ (2 Manage device v

intel-x6000e-out-of-band / Interface / Reboot ()

Run

To see response, please check the command history.

intel-x6000e-out-of-band / Interface /| Shutdown &

To see response, please check the command history.

intel-x6000e-out-of-band / Interface / Power Up @O

Run

To see respanse, please check the command history.

intel-x6000e-out-of-band / Interface /| Decommission ()

To see response, please check the command history.

mands

4. The user can view the device events and responses under the Events View or Raw data tabs.

[z L

& Connect &, Manage template

|®

m
Apj
@,
@

e

Manage device

Dashboarcs Devices > Dell-x6000e-out-of-band > EHL_EGW3200
Devices =  EHL_EGW3200
° Connected | Last data received: 12/6/2021, 7:59:33 PM | Status: Provisioned | Organization: EHL_EGW3200
Device groups
Events View  Overview Commands  Raw data

Rules
Analytics

Events View A
Jobs

Timestamp Event Name Event Value

p settings

2 minutes ago Event Static Telemetry published...
Device templates

2 minutes ago Event Elkhart Lake Qut-of-band App - Start
Data export
Administration 15 minutes ago Event Platform in Active Power state

15 minutes ago Event Platform in Low Power state

15 minutes ago Event Platform Reboot Initiated

15 minutes ago Event Reboot command Triggered

Figure 63. Events View
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Devices > Dell-x6000e-out-of-band » EHL_EGW3200

EHL_EGW3200

Event creation time

Event Platform Architecture

Static Telemetry published...

= ° Connected | Last data received: 12/6/2021, 7:53:33 PM | Status: Provisioned | Organization: EHL_EGW3200
Events View  Qverview  Commands  Raw data
Timestamp | Message type
> 12/6/2021, 7:59:33 PM Property
> 12/6/2021, 7:59:33 PM Telemetry
> 12/6/2021, 7:59:33 PM Property
> 12/6/2021, 7:59:33 PM Property
> 12/6/2021, 7:59:33 PM Property
> 12/6/2021, 7:59:32 PM Telemetry

NN

v

N 12/6/2021 7.45:20 PA

Figure 64. Raw data

12/6/2021, 7:59:32 PM

12/8/2021, T:47:58 PM

12/6/2021, 7:46:24 PM

Telemetry

Telarnate:

Device connected

Command reguest

Elkhart Lake Qut-of-band Ap...

Platform in Active Power state

Dlatfrm in | an Drar cbate

COM Port and Ethernet Names for Mini PCle Cards

Table 6. Mini PCle card details

S.No mPCie module Isolated COM A |lIsolated COM B | Remarks
(port type) (port type)

1 EMP2-X452 RS422/RS485 RS422/RS485 Total of four COM ports are detected in the Device
Manager. However, only two COM ports can be
accessed. Assume that the first COM port of EMP2-
X482 is COM X, as seen in the device manager, then,
based on the cable tag:

RS-422 A - COM X
RS-422 B - COM X+1
RS-485 A - COM X+2
RS-485 B - COM X+3
2 EMP2-X281 RS232 RS232 Total of two COM ports are detected in the Device

Manager. Assume that the first COM port of EMP2-X251
is COM X, then, based on the cable tag:

Isolated COM A - COM X
Isolated COM B - COM X+1

For EMP2-X2S1:

Both EMP2-X2S1 and EMP2-X4S2 use the same VID and DID. By default, the EMP2-X2S1 module uses the driver files of
the EMP2-X4S2 module, and so the device manager shows four COM ports. To overcome this issue, manually install the
EMP2-X2S1 Windows 10 64-bit driver package.
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For EMPL-G2P1 and EMPL-G201:

Get the Ethernet name from Control Panel > Network and Internet > Network Connections, based on the MAC address of
the Ethernet ports.

Sensor APlIs

The sensors of the EGW-3200 use Microsoft default sensor APIs. This section serves as a programming reference of the Win32
APIL. For more details, see the sensorsapi.h header Microsoft page.

Table 7. Console application APIs for ADXL345/HDC1010/DPS310

event.

S.No Console application Description Supported/not
APls supported

1. GetSensorsByType Retrieves a collection containing all sensors associated | Supported
with the specified type.

2. GetData Retrieves the most recent sensor data report. Supported

3. GetAt Retrieves the sensor at the specified index in the Supported
collection.

4. GetCategory Retrieves the identifier of the sensor category. Supported

. GetSensorValue Retrieves a single data field value from the data report. | Supported

6. GetSensorValues Retrieves a collection of data field values. Supported

7. GetCount Retrieves the count of sensors in the collection. Supported

8. GetFriendlyName Retrieves the sensor name that is intended to be seen | Supported
by the user.

9. GetState Retrieves the current operational state of the sensor. Supported

10. SetEventSink Specifies the interface through which to receive Supported
sensor event notifications.

1. GetSensorByID Retrieves a pointer to the specified sensor. Supported

12. GetProperties Retrieves multiple sensor properties. Supported

13. GetProperty Retrieves a property value. Supported

14. GetSupportedDataFields Retrieves a set of PROPERTYKEYs that represent the | Supported
data fields the sensor can provide.

15. SetProperties Specifies sensor properties. Supported

16. Add Adds a sensor to the collection. Supported

17. GetTimestamp Retrieves the time at which the data report was Supported
created.

18. OnDataUpdated Provides sensor event data. Supported

19. OnEvent Provides custom event notifications. Supported

20. Onleave Provides notification that a sensor device is no longer | Supported
connected.

21. OnStateChanged Provides a notification that a sensor state has Supported
changed.

22. GetEventinterest Retrieves the current event interest settings. Supported

23. SetEventinterest Specifies the list of sensor events to receive. Supported

24. SupportsEvent Indicates whether the sensor supports the specified Supported

Setting Up the Windows 10 Operating System

63


https://learn.microsoft.com/en-us/windows/win32/api/sensorsapi/

Table 8. UWP application APIs for ADXL345/HDC1010/DPS310

interfaceld)

S.No UWP application APIs Description Supported/not
supported

1. FromldAsync Asynchronously obtains the sensor from its identifier. Supported

2. GetCurrentReading Gets the current sensor reading.

3. GetDefault Returns the default sensor type.

4. GetDeviceSelector(Guid Gets the device selector.

Table 9. UWP application sensor events for ADXL345

S.No

Event name

Supported/not supported

1.

Choose accelerometer

Supported

Data Events

Polling

OrientationChanged

Shake Events

Not supported? b

HEIEREIE

Data Events Batching

a. The interrupts which can be enabled from the driver side are Single tap, Double tap, Activity, Inactivity, and Free fall (in
INT_ENABLE register). The detection of Shake events is not supported.

b. Data Events Batching is not supported due to the fact that the driver does not implement it.

Table 10. UWP application sensor events for DPS310

S.No Event name Supported/not supported
1. Data Events Supported
2. Polling

Table 11. UWP application sensor events for HDC1010

S.No Event name Supported/not supported
1. Data Events Supported

2. Polling
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Windows troubleshooting

The following tasks describe how to recover from errors when using Windows.

Recover from Install Windows error

About this task

The Install Windows error in the following figure may appear while the system is loading Windows. This is caused by an
unexpected restart or error during the system boot up.

Install Windows

Q The computer restarted unexpectedly or encountered an

_unexpect‘ed error, Windows installation cannot proceed, To
install Windows, click "OK' to restart the computer, and then
restart the installation.

Figure 65. Install Windows error message

To recover from this error, perform the following steps.

Steps

1. Navigate to the Command Prompt, or use the Shift + F10 keyboard shortcut.

2. Type the command: regedit., then press Enter on your keyboard to start the Registry Editor.
3. If prompted by the User Account Control, click Yes.

4. In this new window, navigate to the following path:

HKEY LOCAL MACHINE\SYSTEM\Setup\Status\Child\Completion

o

In the right pane, click setup.exe twice.
Change the Vvalue Data from 1to 3, then click OK to save the change.

7. Close this window and reboot the system.

Recover from .NET Framework installation error

About this task
The .NET Framework error in the following figure may appear while the system boots.

[E Windows Features

The following feature couldn’t be installed:

NET Framework 3.5 (includes .NET 2.0 and 3.0)

The changes couldn't be completed. Please reboot your computer and try again.

Error code: 0x80246008

Figure 66. .NET Framework installation error
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To recover from this error, perform the following steps.

Steps

1. Confirm that the system has a network connection.
2. Download the .NET Framework 3.5 SP1 Web Installer from the Microsoft website.
3. Open the installer and wait for the installation to complete.
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Setting Up the Ubuntu Operating System

This chapter serves as a guide to install and use the Ubuntu 20.04 LTS operating system on the EGW-3200 hardware.

For more information on this operating system, see the Ubuntu 20.04 LTS Home Page.

Topics:

Boot up and log in

Create bootable USB stick for restore

Back up and restore Ubuntu 20.04 LTS

Update BIOS capsule

Update 4G module firmware

Update 5G module firmware

Disabling bands in Ubuntu after firmware update or SIM card change
Ubuntu 20.04 LTS basic functions

Isolated Canbus uFM expansion module

EMP2-X281 card with isolated RS-232 uFM expansion module
EMP2-X4S2 card with isolated RS-422/485 uFM expansion module
Connect a PCA9535 GPIO expander board

Ubuntu troubleshooting

Boot up and log in

Steps

1.

Connect a keyboard, mouse, and monitor to the EGW-3200.

2. Power on the system. The system boots to the Ubuntu 20.04 LTS operating system.

3. Log in to the sysem. At initial login, the user must change the password of the default account.

@l NOTE: The default username/password is ubuntu/ubuntu.

Create bootable USB stick for restore

About this task

Perform this task for restoration of the system.

Steps

1.
2.

Install the image. Download the Ubuntu Desktop image 21.10 or a newer version from the Canonical website.

To create a bootable USB stick, perform the steps in the Create a bootable USB stick on Ubuntu tutorial.

To create a bootable USB stick with Rufus on Windows, perform the steps in the Create a bootable USB stick with Rufus on

Windows tutorial.
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Back up and restore Ubuntu 20.04 LTS

Prerequisites
Before performing the following recovery process, it is recommended to clear the target SSD. For a secure-erase supported
SSD, see SSD security-erase, or use the basic clear command:

$ sudo dd if=/dev/zero of=/dev/sdx bs=<block size> count=<block number> status=progress

Steps

1. For the backup process, perform the following steps to prepare two USB sticks:

a. One USB stick is used to store the target Ubuntu image, and it should have sufficient space to store the backup data.
The space required for the backup is based on the used space on the disk. For example, on a 2 TB disk, if the used
space is 5.4 GB, then the space required on the USB stick should be around 5 GB, as the backup process compresses the
image. For example, a 5.4 GB image is compressed to 1.9 GB, as shown in the following figure.

root@ubuntu: /home/ubuntud df -Th | gqrep "~/dev"”

fdev/sda3 extd 19T 1 "6,4G'>-1.8T 1% / |

/dev/1oopl squashfis 0ZM oM 0 100% /snap/core20/1361
/dev/loopl squashfs 64M 64M 0 100% /snap/core20/1822
/dev/sda2 vfat SOM S5.2M 45M 11% /boot/efi

/dev/loop2 squashfs 68M 68M 0 100% /snap/lxd/22526
/dev/loop3 squashfs 92M 92M 0O 100% /snap/lxd/24061
/dev/loop4d squashfs 44M 44M 0 100% /snap/snapd/14978
/dev/adcl exfat 58G 43G 16G 74% /media/ubuntu/KIOXIA

Figure 67. Image compression

b. Use the following command to back up your SSD data as an image on the USB stick. Depending on the size of the SSD,
this process may take a while. For example, 2 TB takes around three hours to back up.

$ sudo fstrim / | sudo dd if=/dev/sdx status=progress | gzip -c > /media/ubuntu/
<USB stick name>/<image file name>
$ xz -9v /media/ubuntu/<USB stick name>/<image file name>

c. The other USB stick is made as Ubuntu Desktop live USB with version 21.10 or newer, as detailed in Create bootable USB
stick for restore.

2. For the restore process, perform the following steps:
a. Use Ubuntu Desktop live USB to boot up the device by BIOS, and then select Try Ubuntu:
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Figure 68. Try Ubuntu

b. Plug in the USB stick that stores the backup image file, then open the Ubuntu terminal to enter the following command

to flash the backup image into the target SSD:

$ xz —-dv /media/ubuntu/<USB stick name>/<image file name>.xz

$ gzip -dc /media/ubuntu/<USB stick name>/<image file name> | sudo dd of=/dev/sdx

status=progress;sync;

Typically, the image USB stick is mounted under /media/ubuntu/<USB stick name>, and the target SSD is mounted

as /dev/sdx.

This image restore is a slow process. For example, a 2 TB SSD can take up to seven hours.

¢c. When the SSD restore is finished, reboot the platform and boot up with the target SSD.

Results

You can now return to your backup environment.

Update BIOS capsule

Prerequisites

Use the following command to ensure that the fwupd and libjcat1 versions are compatible:
$ apt list --installed | grep -e fwupd -e libjcatl

The fwupd should be v1.7.5 or later, and the libjcat1 should be v0.1.4. If either installed version is lower, use the following
command for an Ubuntu OTA update:

$ sudo apt update; sudo apt upgrade

Steps
1. Download the BIOS capsule file from the Dell Technologies Support Site and save it to the USB disk.
2. Boot to Ubuntu and open the terminal. Enter the following command and press y to restart the system after update.
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To update with the same version:
$ fwupdmgr install <BIOS capsule cab file> --allow-reinstall
To update to a newer version:

$ fwupdmgr install <BIOS capsule cab file>

3. After system restart, provide <password> to enter the BIOS setup page.

Enter Password

Figure 69. BIOS password prompt

4. Select Proceed with flash update item in BIOS Main page.

Please select blocks you want to update select this to start flash
Reset NVRAM [Disabled] il update

Boot Block Update [Enabled] i

- Proceed with flash update

Figure 70. Proceed with flash update

The system starts to install the firmware update, as shown in the following figure:

Figure 71. Firmware update
B. Wait for the update to finish, and then the system BIOS is updated to the version specified.

Update 4G module firmware

Prerequisites

e Update the kernel to 5.15 for driver compatibility.
e Download the driver and tool from the Dell Technologies Support Site.
e Download the firmware from the EM75xx Approved FW Packages site.
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About this task
For 4G LTE Sierra Wireless EM7565, hardware version 1.0, the certified version for each carrier is:

e SWI9X50C_01.14.20.00 for AT&T
e SWI9X50C_01.14.07.00 for Verizon

Steps

1. Unzip and copy the package on your platform with the Ubuntu environment:

$
$
$
$

ubuntu@ubuntu ~/uork/4g/release/R3B Release_V$ 1s

sudo apt install unzip

unzip <firmware>.zip -d <firmware directory>
unzip MBPL DRIVERS R30 ENGl-usb-src.zip
unzip MBPL SDK R30 ENG6-fwdwl.bin.zip

R _ENG1-usb-src MBPL_DRIVERS_R30 ENG1-usb-src.zip MBPL_SDK_R30_ENG6-fwdwl.bin.z1ip
ubuntu@ubuntu -/uork/4g/release/R30 Release V$

2. Build the driver and install it:

$ cd MBPL DRIVERS R30 ENGl-usb-src
$ sudo apt install make gcc
$ make clean

$ make

$ openssl req -new -x509 -newkey rsa:2048 -nodes -days 36500 -outform DER -keyout
"MOK.priv" -out "MOK.der" -subj "/CN=$ (hostname) module signing key/"

$ kmodsign shab5l12 MOK.priv MOK.der gcserial.ko

$ kmodsign sha512 MOK.priv MOK.der gmi_ wwan.Xko

$ kmodsign sha512 MOK.priv MOK.der usb_ wwan.ko

ubuntu@ubuntu:~/work/4g/drvier/usb$ 1s

Makefile gcserial.mod gmi_wwan. ko readme. txt usb_wwan.mod.c
Module.symvers qcserial.mod.c gmi_wwan. usb-wwan.h usb_wwan.mod.o
modules.order qcserial.mod.o gmi_wwan. : usb_wwan.c usb_wwan.o

gcserial.c gcserial.o gmi_wwan. .0 usb_wwan
gcserial. ko gmi_wwan.c gmi_wwan. usb_wwan.
ubuntu@ubuntu:~/work/4g/d rvier/usb$—l

$ sudo make install
$ sudo mokutil --import MOK.der

Enter a password twice. Make a note of this password, as it will be used during bootup.

$ sudo reboot

3. Before the BIOS loads GRUB, the device shows a blue screen called MOK management. Press any key to continue.
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Figure 72. MOK management

4. Select Enroll MOK and follow the menus to finish the enrolling process.

Figure 73. Enroll MOK

Figure 74. Enroll MOK Continue
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Figure 75. Enroll the keys

5. The MOK Management screen prompts for the password that was provided when running mokutil, and then saves the key.
Once complete, reboot again.

Figure 76. MOK management Reboot

6. Upgrade the firmware:

$ sudo systemctl stop ModemManager
$ cd SampleApps/lite-fw-download/bin

ibuntu@ubuntu:~/4G/SampleApps/11te-fw-download/bin$ 1s

# (For Linux kernel 5.13 version, Using R24 driver and R26 tool)

$ sudo ./fwdwl-litehostx86 64 -d /dev/ttyUSBO -p /dev/cdc-wdm0 -f <firmware
directory> -t 1 -w <firmware>.cwe -n <firmware>.nvu

# (For Linux kernel 5.15 version, Using R30 driver and tool)

$ sudo ./fwdwl-litehostx86 64 -f <firmware directory> -t 1 -w <firmware>.cwe -n
<firmware>.nvu N

$ sudo reboot

Use $ sudo mmcli -m <modem number> to confirm the firmware revision.
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Results

A firmware update enables all the bands. For more information, see Disabling bands in Ubuntu after firmware update or SIM card
change.

Update 5G module firmware

About this task

For the Telit Centerion (formerly Thales) MV31-W 5G module, hardware version V065, the certified version for each carrier is
shown below. Only version 1.0.0.9 has been certified, and cannot be upgraded beyond 1.0.0.9.

e T99W175.F0.1.0.0.9.AT.009 for AT&T
e T99W175.F0.1.0.0.9.VZ.009 for Verizon

Steps
1. Firmware update:

a. Download the 5G firmware update tool (mbimcli) and firmware (for example, x64-F0.1.0.0.9(AP077).zip) from the Dell
Technologies Support Site:

®| NOTE: The firmware is updated on the Dell Technologies Support Site when a new version is available.

b. Stop the modem manager and untar the mbimcli tool:

sudo systemctl stop ModemManager
sudo apt-get install unzip

sudo unzip mbimcli.tar.zip

tar Jxvf mbimcli.tar.xz

Uy Uy Uy Uy

¢. Unzip the 5G firmware to your destination path:

$ sudo apt-get install unzip
$ sudo unzip x64-F0.1.0.0.9\ (AP077\) .zip
$ sudo cp x64-F0.1.0.0.9\ (AP077\)/T99W175.F0.1.0.0.9/0ota.bin ./mbimcli/

d. Update the 5G firmware:

$ cd mbimcli
$ sudo ./mbimcli -d /dev/cdc-wdmO --gdu-ota-update=ota.bin
S reboot

2. Install minicom, if not already installed:

sudo apt install minicom

3. Stop the Modem Manager:

sudo systemctl stop ModemManager.service

4. Query the SIM-based firmware switching status with minicom using at~sbfs? The following setting determines if the
firmware switches automatically based on the network carrier SIM card inserted, or if the user desires to set the network
carrier explicitly (for example, AT&T or Verizon).

SIM based FW switching:

at"sbfs=<state>
where state=0 (disabled) or 1(enabled).

For example, to enable SIM-based firmware switching:

at”~sbfs=1 (enable)
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at~sbfs=0 (disable)
@ NOTE: Any change to the setting for sbfs state results in an automatic reset of the module. A reset causes the modem
to be unresponsive for about 60 seconds.

The sbfs setting determines the next steps:

a. If desired sbfs=1, then skip to Step 9.
b. If desired sbfs=0, then additional steps are needed to configure the carrier profile in the modem to match that of the SIM
card.
6. Query the carrier profiles available in modem using at*mcfg="7?. Index O is the current active profile.

7. Query the current profile with at"mcfg?

at™mcfg?
“MCFG: GCF

OK
8. Set desired profile using at“mcfg=<Index#> as shown on the device.

See the example below to set AT&T profile based on the at“mcfg=2 from the previous step.

@ NOTE: Any change to the setting for mcfg profile results in an automatic reset of the module. A reset causes the
modem to be unresponsive for about 60 seconds.

9. When the modem returns from reset, query the current profile with at“mcfg? to verify the desired setting. If not, verify
the sbfs setting again.

at®mcfg?
“MCFG: ATT

10. Exit minicom using the following key strokes: <CTRL-A>, x, <ENTER>.
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11. Restart the modem manager:

sudo systemctl start ModemManager.service

Disabling bands in Ubuntu after firmware update or
SIM card change

Disabling bands is required if operating the device within the United States, as well as in other locations. The FCC sets
limitations to radiated transmit power (EIRP) that are band-specific. Due to the 4G or 5G module installed, and the antennas
provided by Dell Technologies, certain bands must be disabled. As such, additional commands must be sent to the module, under
certain conditions outlined below, to meet FCC requirements.

Disabling bands is required:

e After the firmware in the module (4G or 5G) is updated
e After a SIM card change to a different telecom carrier

The following instructions provide information on how to correctly disable bands for the 4G or 5G module used in the
EGW-3200.

Disable bands on 4G device in Ubuntu

About this task
Disabling of these bands is required to meet FCC EIRP or other requirements.

Perform the following steps to disable LTE bands b42 and b48 on the 4G module.

Steps

1. Install minicom, if not already installed:

sudo apt install minicom

2. Stop the modem manager:

sudo systemctl stop ModemManager.service

3. Open minicom on the com port of the modem:

minicom -D /dev/ttyUSBO

4. Ensure that the modem is responding to commands. Type at or ati to get a response.

Enter the following command to change settings on the 4G Sierra modem:

at'!entercnd="A710"

6. Disable LTE bands 42 and 48, as per FCC requirements, by entering the following two commands:

at!band=0A, "Disable b42 b48",100600000EC00000,00002500BA0E19DF, 0000000000000002
at!band=0A

7. Confirm that the bands are disabled:

at!band?
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8. Reset the modem:

at!reset

@ NOTE: The modem disappears from minicom for about 60 seconds. Then it reappears and can be communicated with
again.

9. When the modem returns from reset, confirm that the bands are disabled:

at!band?

10. Exit minicom using the following key strokes: <CTRL-A>, x, <ENTER>.

11. Restart the modem manager:

sudo systemctl start ModemManager.service

Disable bands on 5G device in Ubuntu

About this task
Disabling of these bands is required to meet FCC EIRP or other requirements.

Perform the following steps to disable LTE bands b30, b42, and b48 on the 5G module.

Steps

1. Install minicom, if not already installed:

sudo apt install minicom

2. Stop the modem manager:

sudo systemctl stop ModemManager.service

3. Open minicom on the com port of the modem:
minicom -D /dev/ttyUSBO
4. Ensure that the modem is responding to commands. Type at or ati to get a response.
5. Disable LTE bands 30, 42, and 48, as per FCC requirements, by entering the following command:

at”slband=LTE,1, 30,42, 48

at”slband=LTE,1,30,42,48

OK
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6. Confirm that the bands are disabled:

at?slband?

8,39,48,41,46,66,71,

7. To reset the device for new band settings to take effect, run the following command:

at+reset
at+reset

OK

@ NOTE: The modem disappears from minicom for about 60 seconds. Then it reappears and can be communicated with
again.

8. Confirm that the bands are disabled:

at?slband?

9. Exit minicom using the following key strokes: <CTRL-A>, x, <ENTER>.

10. Restart the modem manager:

sudo systemctl start ModemManager.service

Ubuntu 20.04 LTS basic functions

System shutdown and restart

Steps

1. Shutdown command:

$ sudo shutdown -h now

2. Reboot command:

$ sudo shutdown -r now
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Ubuntu OTA update

About this task

@ NOTE: Dell Technologies recommends the following OTA update to upgrade to the latest version of the Linux Kernel and

drivers for bug fixes and security issues.

OTA update command:

$ sudo apt update
$ sudo apt upgrade

List installed packages

About this task

List installed packages command:

$ apt list --installed

Update the system name

About this task

Update system name command:

$ sudo nmcli general hostname <NAME>

Change the time zone

About this task

Reference the time and date help information with the following command:

$ sudo timedatectl --help

Root user credential

About this task

Root user credential command:

$ sudo su -

Create new user

About this task

Add user command:

$ sudo adduser <USER NAME>
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Select language

Steps

1. Use the following command to select your preferred language, then select <Ok>.

$ sudo dpkg-reconfigure locales

Figure 77. Configuring locales

2. Select your target language and select <Ok> again.

Figure 78. Default locale for system environment

3. Log out and log in, then use the $ locale command to confirm your language settings.
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Display

About this task

Figure 79. Confirm locale

ubuntu@ubuntu:~% locale

LANG=en US.UTF-8

LANGUAGE=

LC_CTYPE="en_US.UTF-8"
LC_NUMERIC="en_ US.UTF-8"
LC_TIME="en US.UTF-8"
LC_COLLATE="en_US.UTF-8"
LC_MONETARY="en_US.UTF-8"
LC_MESSAGES="en_US.UTF-8"
LC_PAPER="en US.UTF-8"
LC_NAME="en US._UTF-8"

LC_ ADDRESS="en US.UTF-8"

LC TELEPHONE="en US.UTF-8"
LC MEASUREMENT="en US.UTF-8"
LC IDENTIFICATION="en US.UTF-8"

LC_ALL=

Acquire screen output from the D-SUB/DVI/DP ports.

USB

About this task

The Ubuntu OS detects USB devices from the six USB ports on the front I/0 panel.

Use the $ dmesg

grep usb command to check USB devices status.

Configure humidity, pressure, and accelerometer sensors

About this task

Three sensors are ready under the Linux iio interface with specific Linux kernel versions.

The following table is a sample list of seven SKUs with their sensor suite status.

Table 12. SKUs and sensor suite status

ID Sensor Part Humidity/temperature Accelerometer Sensor Pressure Sensor DPS310
suite number Sensor HDC1010YPAT ADXL345BCCzZ
1A No XHOYG No No No
2A Yes KR44F Yes Yes Yes
3A Yes 20544 Yes Yes Yes
4A No 2M7NN No No No
5A Yes VT5G6 Yes Yes Yes
6A No R12R5 No No No
7A Yes DX1TJ Yes Yes Yes

®| NOTE: The humidity and pressure sensors require a kernel version 5.13.0-1011-intel or later.
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®| NOTE: The accelerometer sensor requires a kernel version 5.13.0-1014-intel or later.

Steps

1. To upgrade the kernel, use the following command:

$ sudo apt update
$ sudo apt upgrade
$ reboot

2. After rebooting, use the following command to confirm the kernel version:

$ uname -r

3. Use libiio-utils to fetch sensor data:

$ sudo apt install libiio-utils

4. Use iio utility commands to fetch sensor data. For example, use the following command:

$ iio _info

Example

iio:devi
2 channels found:
nput)
-specific attributes found:
attr ©: input value: 49074

attr 1: oversampling_ratio valu
attr 2: sampling_frequency value: 1

(input)
] Lfic attributes found:
0: input value
: oversamplin
2: sampling_freg

evi : adx1345

3 channels found:

( input)
4 channel-specific attributes found:
attr B: calibbias L 6]
attr raw value: -247
attr 2: sampling_frequenc
attr scale value: €
accel_y: (input)
4 channel-specifi
attr calibbias
attr raw value: 10
attr sampling_frequenc
attr scale value: 0.038300
: (input)
annel-specific attributes found:
calibbias value: @
raw val 1
samplin
scale value: @

Figure 81. Accelerometer sensor example

82 Setting Up the Ubuntu Operating System

160.06006080000

160.000000000




(input)
el-specific attribu

es found:

raw value:
scale valu

(input)

c attributes found:
: integration_time value:

: raw value:

16

2: scale value:

Figure 82. Humidity sensor example

®| NOTE: In the case of a non-sensor SKU, the iio_info utility output is as shown in the following figure:

ubuntu@ubuntu:~$ iio_1info

Library version: 0.19 (git tag: v©.19)

Compiled with backends: local xml ip

usb serial

Unable to create IIO context: No such file or directory

Figure 83. iio_info utility example

Configure Ethernet

Steps

1. The Ethernet cards function in DHCP client mode by default. Use the $ip addr command to confirm.

®| NOTE: The Ethernet card names for port1, port2, and port3 are enp3s0, enp0s29f1, and enp0s29f2, respectively.

2. To set up a static IP address, use the following commands:

a.

-0 Q00U

nmcli
nmcli
nmcli
nmcli
nmcli

nmcli

con down <connection name >

con mod <connection name> ipvé4.addresses <
con mod <connection name> ipv4d.gateway <xx
con mod <connection name> ipvé4.dns <xx.XxXX.
con mod <connection name> ipv4.method manu

con up <connection name>

3. To roll back to dynamic IP by DHCP, use the following commands:

a.
b.
C.

nmcli
nmcli

nmcli

@ NOTE

con down <connection name>
con mod <connection name> ipv4.method auto

con up <connection name>

XX .XX.XX.XX>/24
LXK XX L RXD>
XX . XX>

al

: port2 and port3 ETH PHY LED have different definitions when the ports are assigned to Ubuntu than when they
are assigned to Intel PSE. Make this selection under the BIOS menu by clicking Chipset > PSE Configuration > GBEO
or GBE1. GBEO is port2 and the GBE1 is port3. When Host owned with pin muxed is selected, the port is assigned to

Ubuntu.
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Figure 84. BIOS setting

Table 135. LAN LED behavior for both LAN ports

LED[1]: 0110
LED[0]: 0001

Intel PSE
LED[1]: 0OOM
LED[0]: 0000

enp0s29f2

No-Link: off

yellow

Traffic: blink
yellow

oS LAN controller 1G/100 MbE 1 G/100 MbE 10 MbE 10 MbE
LED[1] LED[O] LED[1] LED[O]
Ubuntu Linux enp0s29f1 and Link: solid green No traffic: solid Off No traffic: solid

yellow

Traffic: blink
yellow

Traffic: blink green

No traffic: off

No traffic: solid
yellow

Traffic: blink
yellow

Traffic: blink green

No traffic: off

Link: solid yellow

@lNOTE: The Ubuntu Linux LED behavior requires a kernel version 5.13.0-1014-intel or later.

Configure WiFi network

About this task

Use the following commands to connect an AP using a WiFi interface (wlp6s0).

Steps
1. Scan APs:

$ nmcli dev wifi list

2. Create a connection to the target SSID. If the AP requires a password, add a password parameter:

$ sudo nmcli dev wifi connect <SSID>

$ sudo nmcli dev wifi connect <SSID> password "<PASSWORD>"
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3. To disconnect from the target SSID:

$ sudo nmcli con down <SSID>

Next steps

Optionally, users can create and delete a WiFi hotspot using the WiFi interface (wlp6s0) by performing the following steps:

1. To create a hotspot connection, use the following nmcli command:

$ sudo nmcli dev wifi hotspot ifname <IF NAME> con-name <CONNECTION NAME> ssid <SSID>

password "<PASSWORD>"

e |F NAME: wilp6s0 on EGW-3200
e CONNECTION NAME: user-assigned
e SSID: user-assigned name for WiFi client device connection

Then use a WiFi client device to connect SSID with PASSWORD.
2. To delete the hotspot connection, use the following nmcli command:

sudo nmcli ¢ delete <CONNECTION NAME>

Configure Bluetooth

About this task

Use the following commands to power on Bluetooth and scan target devices.

Steps

1. Enter bluetoothctl mode:

$ bluetoothctl

2. Power on Bluetooth:

$ power on

3. Scan Bluetooth devices:

$ scan on

adlink@adlink:~% bluetoothctl
Agent registered
[CHG] Controller 58

# power on
Changing power on

# scan
Discovery started
[ 1 Controller
[ 1 Device 17:
[CHG] Device

Figure 85. Scan Bluetooth devices
4. Trust target device by MAC address:
$ trust <MAC>

5. Pair with target device by MAC address:

S pair <MAC>

Setting Up the Ubuntu Operating System

85



6. Connect target device by MAC address:

$ connect <MAC>

7. Disconnect target device by MAC address:

$ disconnect <MAC>

8. Unpair with target device by MAC address:

$ remove <MAC>

Connect 4G or 5G WWAN

Steps

1. Insert your USIM card into the SIM 2 slot. Use the following commands to check the modem status:

$ mmcli -L

ubuntu@ubuntu:~% mmclt -L

/org/freedesktop/ModemManager1/Modem/@ [Cinterion] Cinterion PID 0x00B3 USB Mobile Broadband

Figure 86. Check modem status

In this example, the modem number is O.

S mmcli -m O

/sys/devices/pcif0ne:00/0000:00:14.0/usb2/2-4
option, _mbim

primary por
ports: cdc-wdm@® (mbim), ttyUSBO (at), wwan® (net)

Status unlock retrie sim-pin2 (3)
stat registered
power state: on
access tech: lte
signal quality: 19% (cached)

Figure 87. Modem O status
2. If your USIM card requires a PIN code, the Status is locked. Use the following command to enter your PIN code, change the
state to registered, and allow the USIM card to access a cell site.

$ sudo mmcli -i <SIM NUMBER> --pin=<PIN CODE>

3. Use the following nmcli command to register an auto connection for the target modem and the USIM card:
$ sudo nmcli c add type gsm ifname <IF NAME> con-name <CONNECTION NAME> apn <APN NAME>

Use the following settings:

e |F NAME: the primary port of the mmcli modem log

e CONNECTION NAME: user-assigned

e APN NAME: must be provided by your USIM card ISP owner

If the Telecom provider is emome:

$ sudo nmcli ¢ add type gsm ifname cdc-wdm0O con-name cdc-wdmO apn emome
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4. Use the following command to remove auto connection by CONNECTION NAME:

$ sudo nmcli c¢ delete <CONNECTION NAME>

5. Use the following commands to enable and disable the WWAN service of nmcli:

Enable:
$ nmcli r wwanO on
Disable:

$ nmcli r wwanO off

6. If your USIM card is not detected by the 5G modem module, it may be misaligned with the eSIM slot. Perform the following
steps to switch to the physical slot (SIM 2):

a. Use the following commands:

$ sudo apt install minicom
$ sudo systemctl stop ModemManager.service # stop Modem Manager service.
$ sudo minicom -D /dev/ttyUSBO

b. Use the following AT command to switch the SIM slot:

ATASWITCH SLOT=0

®| NOTE: Value O: physical USIM slot (SIM1); Value 1: physical USIM slot (SIM2).

Identify 4G or 5G module

About this task

There are two ways to identify a 4G or 5G module. Users can either use Minicom, a text-based modem control and terminal
emulator program for Unix-like operating systems; or they can use the modem manager command line interface (mmcli). Both
are detailed in the following sections.

Use Minicom

About this task

For more information about Minicom, visit the Official Website.

Steps

1. Use the following AT commands with the minicom serial tool:

$ sudo apt install minicom
$ sudo systemctl stop ModemManager.service # stop Modem Manager service.
$ sudo minicom -D /dev/ttyUSB2

@ NOTE: To enable user local echo on minicom, use the following command:

$ sudo minicom -D /dev/ttyx # ttyx is serial device, such as ttyUSBO.

Use one of the following methods:
a. CTRL+A, Z, E //local echo On/Off
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Figure 88. Minicom Command Summary
b. CTRL+A, E // local echo On/Off, directly.

Welcome to minicom 2.7.1

OPTIONS: I18n
Compiled on Dec 23 2019, 02:06:26.
Port /dev/ttyUSB2, ©8:00:02

Press CTRL-A Z for help on special keys
ATI

Manufacturer: Sierra Wireless, Incorporated

Model: EM7565

Revision: SWISX50C_01.14.02.00 2e210b jenkins 2020/08/19 14:18:39
IMEI: 353533101461997

IMEI SV: 12

FSN: UFB35786210110

+GCAP: +CG5M

Figure 89. Minicom direct

2. Enter the following AT commands to get module information:
a. ATI
b. AT!IIMAGE?

®| NOTE: This applies to 4G module only.

c. AT!IMPREF?
@| NOTE: This applies to 4G module only.
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Figure 90. Module information

3. Exit minicom:
CTRL+A, X

$ sudo systemctl start ModemManager.service # restart Modem Manager service.

Use mmcli

Steps

Use the following AT commands in the modem manager command line interface (mmcli):

$ sudo systemctl stop ModemManager.service # stop Modem Manager service.
$ sudo /usr/sbin/ModemManager - debug # start Modem manager with debug mode.
#
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sudo
sudo
sudo

Stop

sudo
sudo

D Oy o F A0 A A 3 S

mmcli
mmcli
mmcli

debug

mode

Modem manager 1is a foreground process now.
Open another terminal to send AT command to 4G/5G module

——command="ATI'
--command="AT!IMAGE?' # This is 4G module only.
--command="'AT!IMPREF?' # This is 4G module only.

Modem Manager and restart normal one in service mode.

killall ModemManager
systemctl start ModemManager.service # restart Modem Manager service.

Figure 91. Modem manager command line interface

Change 5G SIM slot and connect to the Internet

Prerequisites

This task requires the following utilities:
e Minicom (AT command)
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mmcli (Modem Manager CLI)
nmcli (Network Manager CLI)

About this task

This example uses the following settings and parameters:

The SIM slot change is from Slot 1 to Slot 2.
The 5G module path index is O from mmcli -L command.

The 5G module port names are cdc-wdmO (mbim), ttyUSBO (at), and wwanO (net) from mmcli -m O command.

The connection name is "Far EasTone / KGT Default".
The APN name is "internet".

Steps

1.

Create a connection name if one does not exist in the system:

$ sudo nmcli c add type gsm ifname cdc-wdmO con-name "Far EasTone / KGT Default" apn

internet

Disconnect the connection:

$ sudo nmcli radio wwan off
$ sudo mmcli -m 0 --simple-disconnect

Stop Modem Manager before manual AT command operation:

$ sudo systemctl stop ModemManager.service

Change and confirm the active SIM slot:

$ sudo minicom -D /dev/ttyUSBO

AT"SWITCH SLOT=1 # Switch active sim slot to SIM2

ATASWITCH SLOT? # Get current active SIM slot

for help on special Keys

TCH_5L0Ta1

AT SWITCH_SLOT?

Figure 92. Switch or get SIM slot

Exit the Minicom application and restart Modem Manager:

sudo systemctl start ModemManager.service
sudo mmcli -m 0 --simple-connect="apn=internet"
sudo nmcli radio wwan on

Uy Uy Uy Ur

Check the wwanO status:

$ ip a show wwanO

sudo nmcli connection up id "Far EasTone / KGT Default"
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[ tpm/

B Shoy

1
5T, MULTICAST ,NOARP, UP, LI > mtu 1560 gdisc fq codel state UK group default gqlen 100880

@ global noprefixroute wwant
64 scope global noprefixroute
f64 scope global mngtmpaddr noprefixroute

valid_1f
ubuntububuntu ;=

Figure 93. Show WWANO

Set up 5G Stand-Alone mode for private networking

Prerequisites

The following instructions require the use of a program to communicate serially over USB with the 5G MV31 module that
is installed in the gateway to send AT commands. Linux has a tool called Minicom that provides this functionality. To install
Minicom within Ubuntu, use the following command:

$ sudo apt -y install minicom

About this task

The following information is to assist in setting up the 5G modem (Telit Centerion, formerly Thales MV31-W) installed in the
gateway for 5G Stand-Alone (SA) Private Networking operation running Ubuntu OS. 5G Standalone operation means that the
modem connects to a 5G Core network.

In order for the modem to connect to a 5G core network, AT commands must be sent to the device to configure it for this
operation, as the default settings for the modem are set for NSA (Non Standalone) operation, which is the typical configuration
with the public MNOs (Mobile Network Operators). 5G NSA means that the device utilizes a 4G Core network to establish the
initial connection for 5G operations.

@ NOTE: 5G Stand-Alone (SA) mode is not supported for mobile network operators (MNOs) with the MV31-W. It is only
supported in private networking usage with the PNProfile. As such, 5G SA cannot be used with carrier networks. In
addition, the MV31-W does not support C-band n77 or n48 band in the United States.

Once Minicom is installed, perform the following steps to set up the device in the 5G SA mode of operation for private
networking.

Steps

1. Stop the Modem Manager service from the Ubuntu command line, if it is running. This frees up the port for communication
with Minicom.

$ sudo systemctl stop ModemManager.service
®| NOTE: The device is assumed to be on USBO, but could potentially use a different ttyUSB port.

2. Open the Minicom terminal to communicate with the modem.

$ sudo Minicom -D /dev/ttyUSBO

3. Once Minicom loads, the following screen or similar appears.
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Welcome to minicom 2.7.1

OPTIONS: I18n
Compiled on Dec 23 2019, 02:06:26.

Port /dev/ttyUSBO, 15:49:53
Press CTRL-A Z for help on special keys

Figure 94. Minicom Welcome screen

Press CTRL-A followed by z for options. Common options are to turn on local echo e to see typed commands or to
configure serial port o.

aind Summary

Commands can be called by CTRL-A <key>

Main Functions Other Functions

C‘

.D Clear Screen....... C
.P

eXit and re

Quit with no

Cursor Kk

Figure 95. Minicom Command Summary

Query the sbfs state of the modem by running the at~sbfs? command.

at”sbfs?
SIM base status: Disable

OK

Figure 96. Query sbfs

If the modem already has sbfs set to O (disabled), go to the next step, otherwise run the at”*sbfs=0 command.

at”sbfs=0

Successfully setting SIM base status as:Disable

0K
Figure 97. Set SIM base status

@ NOTE: Changing sbfs causes the device to automatically reset shortly after the OK response appears. Module reset
may take up to 90 seconds to complete.

This setting disables sbfs. This prevents the firmware from switching automatically based on what SIM card is inserted when
using a private networking profile.

The device port disappears for about one minute as the device automatically resets. The Minicom terminal temporarily
displays the following message:
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6.

94

Figure 98. Temporary message

When the modem returns from reset, the message disappears and it is possible to send commands to the modem again.

Once sbfs has been disabled and the modem returns from reset, run the at“mcfg="2 query. This lists all of the carrier
profiles available on the modem. The active profile is shown in index O.

at"mcfg=7

“MCFG:
0,ATT,0x0a000309
1,PNProfile, 0x0a006501
2,Verizon,0x0a000109
3,GCF,0x0a000804
4,T-mobile,0x0a000506
5,Cosmote,0x0ab06704
6,Thales,0x0a006601
7,ATT2,0x0a005309
8,Telefonica,0x0a0p6308
9,Telefonica,0x0ab00CcOs
10,Swisscom,@x0a@09905
11,0range, ®x0a000b05
12,CT,0x0a001305
13,CU,0x0a001505
14,CMCC,0x02002005
15,Vodafone, 9x02000408
16, Telstra, 0x0a000f08
17,5SBM,0x0a001cOa

18 ,KDDI,0x02000708
19,Docomo, 0x0a000do7

Figure 99. Carrier profiles

®| NOTE: It is also possible to run at*mcfg? to query the current active profile that is in use.

Choose an option: at*“mcfg=<index # for PNProfile>. Choose the Private Networking Profile.

®

NOTE: Changing mcfg causes the device to automatically reset shortly after the OK response appears. Module reset
may take up to 90 seconds to complete.

The PNProfile is selected (index 1), and after five seconds, the modem responds with OK.
The device port disappears for about one minute as the device automatically resets. The Minicom terminal temporarily
displays the following message:

Figure 100. Temporary message

When the modem returns from reset, the message disappears, and it is possible to send commands to the modem again.

After the modem returns from reset, run the at"mcfg? or at"version? command to ensure that the PN profile has
been selected. If PN is shown in response for firmware version, then the Private Networking Profile has been selected. The
PN profile is the only setting that allows a 5G SA Private Network connection.
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at”™mcfg?
“MCFG: PNProfile

0K

ati

Manufacturer: Thales

Model: MV31-W

Revision: T99W175.F9.1.0.0.9.PN.001 1 [Jan 18 2022 06:00:00]
SVN: 61

IMEI: 3559/798608375209

+GCAP: +CGSM

MPN: 34

OK

at”version?
“VERSION: T99W175.F0.1.0.0.9.PN.001.077

OK

Figure 101. PNProfile, Manufacturer, and Version

. Query at”slmode?. This ensures the proper mode for 5G operation.

at™slmode?
~“SLMODE:1,7

OK

Figure 102. Query simode

The default is 1, 7; however, values of 4, 5, or 6 can be used, as long as the value selected for <pref mode> includes
NR5G. The at~slmode? query returns two values: <pref term> and <pref mode>.
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Parameter Value Instruction

<pref_term> 0 NON-PERMANENT
(Mode settings restore to last settings after module
reboot)
1 PERMANENT

(Mode settings still is valid after module reboot)

WCDMA And NR5G
LTE And NR5G
WCDMA And LTE And NR5G

<pref_mode> 0 Automatically
1 WCDMA Only
2 LTE Only
3 WCDMA And LTE
4 NR5G Only
5
6
7

Figure 103. <pref_mode> values

To set the SLMODE, use at"slmode=<pref term >,<pref mode>.

10. Check and/or set the at*nr5g mode?. For private networking, SA only, set at*nr5g mode=2.

at™nr3g mode=2

OK

at™nr5g mode?
“NR5G MODE:2

OK

Figure 104. Set Private Networking mode

See the following for 5G mode settings.

Parameter Value Instruction

<nrig_mode> o Enable NR5G NSA and SA mode
1 Enable NRSG NSA made only
2 Enable MR3G 5A mode only

Figure 105. 5G mode settings

11. Configure the bands.

Changing to the PNProfile enables all the bands in the hardware. This may not be desirable, as additional bands are not
required in the private networking use case and may slow the network search time for attaching the device. After changing
to the PNprofile, disable any unnecessary bands for the private networking application. The following figure shows the
bands available with at*s1band? after setting the PNprofile (all bands enabled).
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at”slband?

WCDMA,Enable Bands :1,2,4,5,6,8,9,19,

WCDMA,Disable Bands:

LTE,Enable Bands :1,2,3,4,5,7,8,12,13,14,17,18,19,20,25,26,28,29,30,32,34,38,39,40,41,42,46,48,66,71,
LTE,Disable Bands:

NR5G,Enable Bands :1,2,3,5,7,8,12,20,28,38,41,66,71,77,78,79,
NR5G,Disable Bands:

Figure 106. Available bands

Use the following command to disable any 5G band which is enabled after setting the PNprofile. A value of 1is used to
disable, and 2 for enabling.

at”slband= NR5G, 1,<bandl> [, <band2> [,<band3>..]]

@ NOTE: For any new band restrictions to work, the card must be reset by running the at+reset command after making
changes to the slband settings.

Type Coemmand Possible Return Result  Instruction
Test Command AT*SLBAND=? ASLBAND: <tech> <band= Get the bands range for
OK different mode.
Read AT*SLBAND? <tech> <status> <band> Query the current bands
Command OK status for WCDMA, LTE
and NR5G Sub6G, NR5G
mmWave
Wiite Command AT*SLBAND=<tech=, <status >, OK Enable/Disable bands for
<band1> [, <band2> [, WCDMA/LTE/NRSG
<band3=_. ]| SubBG/MNESGE mmWave
Exec Command AT*SLBAND OK Recover the current
camer default
configuration.

Figure 107. Command syntax
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Parameter Value Instruction

=tech> WCDMA WCDMA mode
LTE LTE mode
NRSG NR5G mode
NRSG_MMW NR5G FR2 bands(If you device support NR5G FR2
Bands)
<status= 1 Disable band status.
2 Enable band status.
<band= List of <band= WCDMA: 1,24586,8919

LTE1,234578.12.13,14,17.18,19,20,25 26,28 29 3
0,32,34,38,39,40,41,42 46 48,66,71,(43)
NR5G_NSA_Sub6G:

1,2,3,5,7,8,12,20,28,38 41,66,71,77,78,79,(,25,40,48)
NR5G_SA_Sub6G:

1,23.,5.7.8,12.20,28 38 41,66,71,77,78,79,(25,40,48)
NR5G_FR2:(257,258,260,261)

Note: Your device may not support some band like *

Figure 108. Parameters

Example: Disable 5G bands 66, 71, and 77:

at*slband=nrb5g,1,66,71,77

at”slband=nr5g,1,66,71,77

0K

at”slband?

WCDMA,Enable Bands :1,2,4,5,6,8,9,19,

WCDMA,Disable Bands:

LTE,Enable Bands :1,2,3,4,5,7,8,12,13,14,17,18,19,20,25,26,28,29,30,32,34,38,39,40,41,42,46,48,66,71,

LTE,Disable Bands:
NR5G,Enable Bands :1,2,3,5,7,8,12,20,28,38,41,78,79,
NR5G,Disable Bands:66,71,77,

Figure 109. Disable bands

Followed by at+reset to take effect.

at+reset

OK

Figure 110. Reset

@ NOTE: To remove any bands what were disabled and revert any changes to slband, run the at~slband command with
no arguments and reset the device again.

12. Query the active SIM slot using at~switch slot? and adjust if necessary. The default SIM for the gateway is SIM slot 1,
but this can be changed if slot 2 is preferred.
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13.

14.
15.

16.
17.

18.

19.

at”switch slot?

SIM1 ENABLE

OK

Figure 111. SIM slot selection

The gateway SIM slots are mapped as follows:
e Enable SIMslot1=at*switch slot=0
e Enable SIMslot 2 = at*switch slot=1

Insert a SIM card in the desired slot (matching that of the previous step) to ensure that the SIM card can be read. Read
the SIM using at+cpin? or at+cimi. The response from the modem should be similar to the following figure, otherwise an
error is returned.

at+cpin?
+CPIN: READY

OK
at+cimi

310170899686192

OK

Figure 112. Example response from SIM card

Once complete with all AT commands, exit Minicom using the following keystrokes in succession: CTRL-A, z, x, <Enter>.

Restart the Modem Manager service in Ubuntu by running the following command. Modem Manager must be restarted for
the device to connect to any network.

$ sudo systemctl start ModemManager.service

Ensure that the SIM card is inserted into the active SIM card slot of the gateway.

Ensure that the four WWAN antennas are attached to the appropriate WWAN RF ports of the EGW-3200 (ANT3, ANT4,
ANTS, ANTB).

Verify connection of the Modem Manager to query the device by running the mmc1i -1 command.

ubuntu@ubuntu:~% mmcl1

forg/freedesktop/ModemManager1/Modem/0® [Cinterion] Cinterion PID ©x08B3 USB Mobile Broadband

Figure 113. Verify modem connection

@ NOTE: It may take up to one minute for the modem to appear after issuing this command. Keep reissuing the command
until the modem is available.

Run the mmcli -m 0 command to view the details for the Modem Manager service. This example shows the modem on
Modem/0.
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device: /sys/devices/pci0000:00/0000:00:14.0/usb2/2-4
drivers: option, cdc mbim
plugin: cinterion
primary port: cdc-wdm@®
ports: cdc-wdm@ (mbim), ttyUSBO (at), wwan® (net)

unlock retries: sim-pin2 (3)
state: registered
power state: on
access tech: lte
signal quality: 19% (cached)

Figure 114. Modem Manager details

@ NOTE: The status of the modem from mmc1i -1 provides information about the SIM, state of the modem on the
network (registered, connected, and so on), as well as the technology and signal quality seen by the device through the
WWAN antennas.

20. There are two ways to connect the modem to the network with known APN. Choose one of the following methods:

a. Use Modem Manager (mmcli) using Simple Connect for the APN setting. The APN NAME must be provided in the
following format:

sudo mmcli -m 0 --simple-connect="apn=<APN NAME>"

:~% sudo mmcli -m @ --simple-connect="apn=213x.m2m.com.attz"

ssfully connected the modem

Figure 115. Modem Manager Simple Connect

To disconnect from the network:

sudo mmcli -m 0 --simple-disconnect

% sudo mmcli -m @ --simple-disconnect

successfully disconnected all bearers in the modem

Figure 116. Modem Manager simple disconnect

b. Use Network Manager (nmcli) commands to register an APN. This only needs to be done once for any given IF NAME, as
results are stored in Network Manager.

$ sudo nmcli c add type gsm ifname <IF NAME> con-name <CONNECTION NAME> apn <APN
NAME>

o </F NAME> should be the primary port of mmcli modem log (for example, cdc-wdm0Q). This is shown when the mmc1i
-L command is used, under System. See the previous figure.

o <CONNECTION NAME> is a reference to the connection name in Network Manager. This is user-defined and can be
any name to identify this network connection.

o <APN NAME> depends on the SIM card that is installed for the private network. Consult your Private Network for
the proper APN details.

Examples:
Connection Name = myPrivate Network

APN name = m2m.data.com

sudo nmcli c¢ add type gsm ifname cdc-wdmO con-name myPrivateNetwork apn
m2m.data.com

Once the network connection has been created, the modem can be connected or disconnected from the network using
the following two commands in Network Manager:

e Disconnect from network: sudo nmcli ¢ down <CONNECTION NAME>
e Reconnect to network: sudo nmcli ¢ up <CONNECTION NAME>
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@ NOTE: Use this command to remove any network connection: $ sudo nmcli c delete <CONNECTION
NAME >

21. Confirm connection to the network again using one of the following commands:
¢ mmcli —m O
e Monitor in the terminal window in real time using mmcli -m 0 -w.

Access GPS

About this task

There are two ways to access GPS. Users can either use Minicom, a text-based modem control and terminal emulator program
for Unix-like operating systems; or they can use the modem manager command line interface (mmcli). Both are detailed in the
following sections.

Use Minicom

About this task

For more information about Minicom, visit the Official Website.
Steps
1. Access the modem console (ttyUSBO) using Minicom:

$ sudo apt install minicom
$ sudo systemctl stop ModemManager.service # stop Modem Manager service.
$ sudo minicom -D /dev/ttyUSBO

2. Enter the following AT commands to enable the GPS function:
AT+GPS?
Return result of 1indicates that the modem module supports the GPS function.
AT+GPS=1

If modem feedback is “GPS is enabled, module reboot”, reboot device one and use the $ sudo minicom -D /dev/
ttyUSBO command a second time.

3. To access TTFF and CN GPS data, use the following AT commands:
AT~GPS_START=0

AT+GPS_INFO
$ sudo systemctl start ModemManager.service # restart Modem Manager service.

Use mmcli

Steps

To get GPS location fixing using mmcli, use the following commands:

sudo mmcli -m 0 \
--location-enable-gps-raw \
--location-enable-gps-nmea

mmcli -m 0 --location-status

$ sudo mmcli -m 0 --location-get
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JEFFFFF, 1FF

Figure 117. GPS location fixing

Remote login

About this task

The SSH server runs by default on port 22. Use your PC/NB to open a SSH connection (using terminal tools such as PuTTY or
MobaXterm) to the EGW-3200. The PC/NB and EGW-3200 share a network connection under a local network.

Set up audio and microphone

Steps
1. Install ALSA utilities:

$ sudo apt install alsa-utils

2. Adjust audio and microphone volume by alsamixer:

$ alsamixer

3. Prepare an audio .wav file and connect to the speaker on the device:

$ aplay xxx.wav

4. Connect to the microphone on the device and start to record audio after entering the following command. Use ctrl + ¢ to
stop the recording.

$ arecord xxX.wav

5. To replay the .wav file recording:

$ aplay xxx.wav

SSD security-erase

About this task

|CAUTION: Performing this task will permanently swipe the disk content.

Steps

1. Check out your target disk to be mounted as /dev/sdx:

$ sudo lshw
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al id: e
logical name: scsil
capabilities: emulated
*-disk
description: ATA Disk
product: SATA SSD

physical

version: BB.3

serial: SSD210628001000003

size: 238G1B (256GB)

configuration: ansiversion=5 logicalsectorsize=512 sectorsize=512

Figure 118. $ sudo Ishw

2. Confirm that the target disk is not frozen. To check:

$ sudo hdparm -I /dev/sdx

o ]

Master password revision code = 65534
upported
[ ) -‘_
locked
frozen
expilred: security count
supported: enhanced erase
20min for SECURITY ERASE UNIT. 60min for ENHANCED SECURITY ERASE UNIT.

Figure 119. Example: target disk is frozen

If the target disk is frozen,
a. Use the following commands to enter the system into standby mode:

$ sudo su -
$ echo -n mem > /sys/power/state

The power button LED blinks when the system is in standby mode.
b. Press the power button once to wake up the system.
c. Use the hdparm command a second time, and status is now “not frozen”, as shown in the following figure:

2

"Master password revision code = 65534
supported

locked
frozen
expired: security count
supported: enhanced erase
20min for SECURITY ERASE UNIT. 60min for ENHANCED SECURITY ERASE UNIT.

Figure 120. Disk not frozen
3. Set up a security password before executing the security-erase:

$ sudo hdparm --user-master u --security-set-pass <password> /dev/sdx

adlink@adlink:~% sudo hdparm --user-master u --security-set-pass 1234 /dev/sda
security password: "1234"

/dev/sda:
Issuing SECURITY SET PASS command, password="1234", user=user, mode=high

Figure 121. Set security password
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4. Run the security-erase command with the password:

$ sudo hdparm --user-master u --security-erase <password> /dev/sdx

adlink@adlink:~$ sudo hdparm --u er 1234 /dev/sda
security password: "1234"

/dev/sda:
Issuing SECURITY ERASE command, password="1234", user=user

Figure 122. Security erase

Results

When the security-erase is finished, all data on the /dev/sdx disk is swiped (0x00).

Get system current and voltage

Steps

1. Download the Read_Voltage_and_Current.zip file from the Dell Technologies Support Site and unzip it to a local folder
location.

2. Run the following commands:

chmod a+x [current voltage script]
sudo ./[current voltage script] # get current and voltage with root privileges.

Connect to the serial port

Steps
1. Connect suitable DB9 cables to the device COM ports.

e Map COM1 port to /dev/ttySO.
e Map COM2 port to /dev/ttyS1.

2. Set the control mode as RS232/RS422/RS485 from the BIOS menu. Map the pins according to the following table:

Table 14. DB9 connector pin definitions

Pin Signal name
RS-232 RS-422 RS-485

1 DCD TXD422- 485DATA-
2 RXD TXD422+ 485DATA+
3 TXD RXD422+ N/S

4 DTR RXD422- N/S

5 GND N/S N/S

6 DSR N/S N/S

7 RTS N/S N/S

8 CTS N/S N/S

9 RI N/S N/S
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3. Execute the following command on two systems, where # is the port number corresponding to the port being used:

$ sudo chmod 777 /dev/ttyS#

4. To test COM port loopback, use the following commands.
a. Data receive command:

$ cat < /dev/ttyS#

b. Data transmit command:

$ echo "test" > /dev/ttyS#

®| NOTE: The port number (#) must be different between data receive and data transmit.

Connect to the Canbus

Steps

1. Install the tool:

$ sudo apt install can-utils

2. Enable the Canbus interfaces:

$ sudo ip link set canO type can bitrate 500000
$ sudo ip link set up canO
$ sudo ip link set canl type can bitrate 500000

3. Receive can frame from a terminal:

$ candump canl

ubuntu@ub
canl
canl

canl
canl
canl

4, Send can frame from another terminal:

cansend can0O 123#9995
cansend can0O 123#9996
cansend canO 123#9997
cansend can0 123#9998
cansend canO 123#9999

Uy Uy Uy Uy Ur

ubuntu@ubuntu:/% cansend can® 123#9995
ubuntu@ubuntu:/% cansend cand 9996
ubuntu@ubuntu:/% cansend can® 123#9997

ubuntu@ubuntu:/$ cansend can® 123#9998
ubuntu@ubuntu:/% cansend can® 123#9999
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Mount USB storage

Steps

1. Plug your USB storage into the device and use the following command to identify the disk as /dev/sdxx:

$ sudo fdisk -1

: 3.77 GiB, 4026531840 bytes, 7864320 sectors
Storage Media
tors of 1 * 512 512 bytes
): 512 bytes / 512 bytes
2 bytes / 512

Sector size (logical/phys
I/0 size (minimum/optimal)
Disklabel type: dos

Disk identifier: 0x1a57b3a2

Device Boot Start End Sectors
/dev/sdbl * 2048 7864319 7862272

Figure 123. Identify USB storage

2. Create a directory to be the mount point:

$ mkdir /tmp/storage

8. Mount storage on /tmp/storage:

$ sudo mount /dev/sdbl /tmp/storage
$ sudo umount /tmp/storage

ubuntu@ubuntu:~% mkdir /tmp/storage
ubuntu@ubuntu sudo mount /
ubuntu@ubuntu /tmp/storage
EFI auto

S on
ub @ sudo umount /
ubuntu@ubuntu 1s /tmp/storage

Figure 124. Mount USB storage

Configure watchdog

Steps

1. Install watchdog service:

$ sudo apt update
$ sudo apt install watchdog

2. Edit /etc/default/watchdog:
$ sudo vim /etc/default/watchdog
Edit watchdog_module parameter as below:

#load module before starting watchdog
watchdog module="w83627hf wdt"

3. Edit /etc/watchdog.conf:

$ sudo vim /etc/watchdog.conf
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Ensure that the following parameters exist in the configuration and are not disabled as comment code.

retry-timeout = 60
repair-maximum = 1
watchdog-device = /dev/watchdog
interval = 1

logtick = 1

log-dir = /var/log/watchdog
realtime = yes

priority = 1

Add a new parameter:

# To set the watchdog device timeout, default is 60 seconds
watchdog-timeout = 20

4. Reboot the device once, then use the following commands to confirm that the driver and service are working:

$ dmesg | grep -i w83627hf wdt

ubuntu@ubuntu:~% dmes ep -1 w83627hf_wdt
86.962370] f WDT driver for NCT6182 Super I1/0 chip initialising

86.962485] w f wdt: Watchdog already running. Resetting timeout to 60 sec
86.962725] /hf initialized. timeout=60 sec (nowayout=0)

Figure 125. View watchdog

$ modinfo w83627hf wdt

filename: /115/modu7eqf5 137 0 1007-1intel/kernel/drivers/watchdog/w83627hf_wdt. ko
description: w83627hT/thf WDT driver
author: Padraig Brady <P@draigBrady.com>

GPL

8D9B77A50B97255CB77868B

retpoline: Y
intree: Y
name : wB83627hT_wdt
ic: 5.13.0-1007-1intel SMP mod_unload modversions
PKCS#7
time autogenerated Kernel key

s 1g ha:ha]go éha

Figure 126. Watchdog info

$ service watchdog status

ubuntu@ubuntu:~$ service watchdog status
i g daemon
Loaded: 1 Lib /¢ temd/qvqtem/watchdog.qerv1ce
Active: ive (runni since Tue 2021-
Proc : StartPre=/bin/sh -c [

Proc 2 : Start=/bin/sh -c [ $run
Main PID 1047 (watchdog)
Tasks: 1 (limit: 9265)
Memory: 712.0K
CGroup: /system.slice/watchdog.service
L1047 /usr/sbin/watchdog

Figure 127. Watchdog status

5. To test the watchdog device, force the Linux kernel to crash:

$ sudo sysctl -w kernel.sysrg=1
$ sudo su -
$ echo ¢ > /proc/sysrg-trigger
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The system hangs and watchdog reboots the system after 20 seconds (if watchdog-timeout = 20).

Configure GPIO

About this task

The EGW-3200 is equipped with six Digital in and six Digital out. To access the registers to read and write to them, perform the
following steps.

Steps

1. Run the following command:

$ sudo su -

2. Export GPIO:
$ echo 369 > /sys/class/gpio/export

369 GPIO is USER_LED_1, 370 GPIO is USER_LED_2, and 371 GPIO is USER_LED_3.

jpquuJ jplw-hlrl”? jplﬂkhlL_]5

Figure 128. Export GPIO

®| NOTE: 369 is for kernel v5.13 only.

3. Check the GPIO direction and value using the following commands:

$ cat /sys/class/gpio/gpio369/direction
$ cat /sys/class/gpio/gpio369/value

®| NOTE: 369 is for kernel v5.13 only.

4. Set the GPIO value using the following command:

$ echo {0 or 1} > /sys/class/gpio/gpio369/value

root@ubuntu:/home/ubuntu# cat /sys/class/gpio/gpio369/direction
ou't
root@ubuntu:/home/ubuntu# cat /sys/class/gpio/gpio369/value

1
root@ubuntu: /home/ubuntu# ech

Figure 129. Set GPIO value

®| NOTE: 369 is for kernel v5.13 only.

Results
The low level triggers the USER_LEDs. When the value is O, the USER_LED is illuminated, as shown in the following figure.
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Figure 130. GPIO USER_LED illuminated

The following tables show the GPIO export values.

Table 15. GPIO export values for kernel 5.13.0-xxx-intel

LED Export value Digital output Export value Digital input Export value
U1 369 DOO 474 DIO 372

U2 370 DO1 473 DI 373

U3 371 DO2 471 DI2 374

— DO3 472 DI3 375

— DO4 400 DI4 385

— DO5 404 DI 386
Table 16. GPIO export values for kernel 5.15.0-xxx-intel

LED Export value Digital output Export value Digital input Export value
U1 881 DOO 986 DIO 884

U2 882 DO1 985 DI 885

U3 883 DO2 983 DI2 886

— DO3 984 DI3 887

— DO4 912 DI4 897

— DO5 916 DI5 898

TPM tasks

About this task

If TPM is turned on, the device node (/dev/tpm0) exists.
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Figure 131. TPM on

If TPM is turned off, the device node (/dev/tpmO0) does not exist.

ubuntu@ubuntu:/dev$ 1s /dev/tpm@

ls: cannot access '/dev/tpm@': such file or directory

Figure 132. TPM off

TPM can be enabled/disabled from the BIOS Advanced menu > TPM 2.0 Configuration > Security Device Support.

List PCR values

About this task

Use the following command:

$ sudo tpm2 pcrread

Results

The tpm2_pcrlist is renamed to tpm2_pcrread.

Get random data by TPM

About this task

Use the following command:
$ sudo tpm2 getrandom -o <output file> <number of random bytes>
For example:

$ sudo tpm2 getrandom -o random.out 20

Get hash by TPM

About this task

Use the following command:
sudo tpm2 hash -g <algorithm> -o <output data> <input data>
For example:

$ echo "Dell" > message
$ sudo tpm2 hash -g shal -o hash.bin message
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Wake events

Trigger Ubuntu OS to enter S3 status
Steps
1. Use the following command:

$ sudo su

2. Use the following command:

$ echo mem > /sys/power/state

3. Use a USB keyboard to enter any key to wake up the Ubuntu OS.

@ NOTE: Use a physical keyboafd to wake up the system. If the keyboard is on a remote SSH session, the box does not
wake up.

Use RTC as wake event

Steps

1. Use the following command:

$ sudo rtcwake -u -s <second> -m <mode>

2. The <mode> can use the mem parameter to enter S3, and the off parameter can enter Sb.

Wake-on-LAN

Steps
1. Make Ubuntu OS of target device enter S3 or Sb.
2. Using another Ubuntu OS device that is working under the same local network, use the following commands:

$ sudo apt install wakeonlan
$ wakeonlan <target device NIC MAC>

For example:

$ wakeonlan 00:30:64:3a:ad:80

Results

The target device is waked up as a result of the Wol function.

Wake-on-WLAN

Prerequisites

If the device is not already connected to a WiFi network, see Configure WiFi network to connect.
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Steps

1.

2.

Use the following command to check the AX210 WiFi card WoWLAN status:

$ iw phy0 wowlan show

If WoOWLAN is disabled, use the following command to enable it:

$ sudo iw phy0 wowlan enable magic-packet

3. Use the i fconfig command to make sure your WiFi card (wlp6s0) is connected on a SSID to get an IP address. Record
the IP and WiFi MAC address.

Use another WiFi client device that is connected to the same SSID and trigger Wol magic packet to wake up the target

device.

For example, use an Android smart phone to install the WoL tool (available on the Wake On LAN page of the Google Play
site), then enter the IP and MAC address of the WiFi card of the target device. Trigger the WolL magic packet using the tool
to wake up the target device.

Isolated Canbus uFM expansion module

Steps
Download the utility tool (EMUC-B202.zip) from the Innodisk official website: EMUC-B202 Driver
2. Unzip the file and copy the driver package onto your platform with the Ubuntu environment.

3. Unzip Linux/EMUC-B202_API_Linux_<DATE>.zip, using the following commands:

1.

$ cd EMUC-B202-W1l CAN API V2.3.7 Linux/Loopback EMUC2
$ sudo chmod +x emuc_ 64
$ sudo ./emuc_ 64

Round

1:

( CAN

( CAN
( CAN

( CAN
( CAN

( CAN
( CAN

Figure 133. EMUC-B202 API

00000001 ; Data:
00000001; Data:

00000001 ;
00000001 ; Data:

00000002; Data:
00000002;

00000002;
00000002; Data:

4. Edit the setup.ini file for different test cases, as detailed in the following table.
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Table 17. Setup.ini settings

Parameter Settings

COM Port 0 = auto scan (Windows), —1 = auto scan (Linux)

Baud rate 4 = 100K, 5 = 125K, 6 = 250K, 7 = 500K, 8 = 800K, 9 = 1M
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Table 17. Setup.ini settings (continued)

Parameter Settings

Interval 1, 2, ..., 1000 [ms], sending interval between each frame

Test time 0 =once, 1, 2, ..., 60 [min], length of test time

Test file Pattern.txt file includes ID and data used for sending test frames.
Log file Log.txt is used for saving the test result.

B. Before starting the test, prepare a special port cable that can jump each pin. Connect cable-A and cable-B as below:
Cable-A-pin2 and cable-B-pin2 are connected using a cable.

Cable-A-pin7 and cable-B-pin7 are connected using a cable.

EMP2-X2S1 card with isolated RS-232 uFM expansion
module

About this task

Map the pins according to the following table.

Table 18. RS-232 pin assignment

Signal Pin

CD 1

RXD

TXD

DTR

GND
DSR

RTS

CTS

Ol 0| N Ooo|lo| D] NN

RI

The EMP2-X2S1 uFM card supports two RS-232 ports, however there are four ports from the OS, as shown in the red box in
the following figure:

Figure 134. RS-232 ports

Use the first two ports, ttyS6 and ttyS7, as shown in the red square in the previous figure, for the RS-232 port function. The
test method references the "serial port" section.
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EMP2-X4S2 card with isolated RS-422/485 uFM
expansion module

About this task

Map the pins according to the following table.

Table 19. RS-422/485 pin assignment

RS-422 full duplex Pin RS-485 half duplex
- 1 -
TX+ 2 D+
RX+ 3 -

- 4 -
GND 5 GND
- 6 -
RX- 7 -
TX- 8 D-

- 9 -
Steps

1. Download the latest driver (EMP2-X4S2_Linux_driver_<DATE>.zip) from the Dell Technologies Support Site. Unzip the file
and copy the driver package on your platform with the Ubuntu environment.

2. Use the following cd commands in the driver directory.

$ sudo apt install make gcc
$ sudo make clean
$ sudo make

$ openssl req -new -x509 -newkey rsa:2048 -nodes -days 36500 -outform DER -keyout
"MOK.priv" -out "MOK.der" -subj "/CN=$ (hostname) module signing key/"

$ kmodsign sha512 MOK.priv MOK.der xrl7v35x.ko

$ sudo make install

$ sudo vim /etc/modules-load.d/modules.conf

3. Add xr17v35x into the file to make Ubuntu auto load this driver during boot up.

$ sudo vim /etc/modules-load.d/modules.conf

4. Add blacklist 8250_exar into the file to make the standard serial port driver not conflict with xr17v35x.

$ sudo vim /etc/modprobe.d/blacklist.conf

@ NOTE: This step is to roll back the modifications of modules.conf/blacklist.conf by the EMP2-X281 driver if you
previously used the EMP2-X2S51 card.

$ sudo mokutil --import MOK.der
Enter your password twice.
$ sudo reboot

While the BIOS loads GRUB, the device displays a blue screen for MokManager. On this screen, perform the following
steps:
a. Select Enroll MOK.

14 Setting Up the Ubuntu Operating System


https://www.dell.com/support/home/en-us/product-support/product/dell-edge-gateway-3200/overview

Use the menus to finish the enrolling process.
Use the same password used when running mokutil.
Save the key.

® o 0 o

Reboot again.

. For RS-422, use RS-422 cables with the EMP2-X4S2 card.

For the RS-422 port-to-port test, connect the RS-422-A and RS-422-B as detailed in the following:
e RS-422-A-pin2 and RS-422-B-pin3 are connected with a cable.
RS-422-A-pin3 and RS-422-B-pin2 are connected with a cable.
RS-422-A-pin7 and RS-422-B-pin8 are connected with a cable.
RS-422-A-pin8 and RS-422-B-pin7 are connected with a cable.

. After the RS-422 hardware is prepared, open two terminal windows.
For the first terminal window:

$ sudo minicom -D /dev/ttyXRO
For the second terminal window:
$ sudo minicom -D /dev/ttyXR1

Type some words in the first terminal to confirm that you can see the words displayed in the second terminal.
For RS-485, use RS-485 cables with the EMP2-X4S2 card.

For the RS-485 port-to-port test, connect the RS-485-A and RS-485-B as detailed in the following:

e RS-485-A-pin2 and RS-485-B-pin2 are connected with a cable.

e RS-485-A-pin8 and RS-485-B-pin8 are connected with a cable.

. After the RS-485 hardware is prepared, open two terminal windows.
For the first terminal window:

$ sudo minicom -D /dev/ttyXR2
For the second terminal window:
$ sudo minicom -D /dev/ttyXR3

Type some words in the first terminal to confirm that you can see the words displayed in the second terminal.

Connect a PCA9535 GPIO expander board

About this task
A PCA9535 GPIO expander board and connector are shown in the following figure.

v OIVO-TL0 3
p4ooq OI OOIEMO3

Figure 135. PCA9535 GPIO expander board and connector
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The PCA9535 7-bit device address is 0x20.
CN13 is the connector for the PCA9535 expander. CN13 is connected to 12C bus #3, as shown in the following figure.

TS6AGMTS666

"llll mn lll|
S/N: G933 11 0

- ]

UL TN

12 2001 Fw

Made in Tarwa [+ ]~

Figure 136. Board connection for the PCA9535 GPIO expander

Steps
1. Connect the expander board according to the previous figures, then reboot the system.
2. Install the i2c-tools using the following command:

$sudo apt update
S$sudo apt -y install i2c-tools

3. The probe function of the i2c-dev driver does not necessarily map to a fixed bus number, so the mapping system node is not
always the same after a system reboot. To resolve this, perform the following sub-steps:

a. Scan and list the 12C bus controllers, and see that there are seven i2c buses, as shown in the following example:

$ sudo i2cdetect -1 | grep -i Synopsys

i2c-3 i2c Synopsys DesignWare I2C adapter I2C adapter
i2c-1 i2c Synopsys DesignWare I2C adapter I2C adapter
i2c-6 i2c Synopsys DesignWare I2C adapter I2C adapter
i2c-4 i2c Synopsys DesignWare I2C adapter I2C adapter
i2c-0 i2c Synopsys DesignWare I2C adapter I2C adapter
i2c-7 i2c Synopsys DesignWare I2C adapter I2C adapter
i2c¢c-5 i2c Synopsys DesignWare I2C adapter I2C adapter

The PCA9535 is on one of these ${busnum} nodes.

b. Perform the following command to check all I2C nodes until the register 0x02 of device address 0x20 (PCA9535) has a
standard output Oxff, which means that a PCA9535 has been found on ${busnum}.

$ sudo i2cget -y S{busnum} 0x20 0x02 2>/dev/null

For example:

$ sudo i2cget -y 3 0x20 0x02 2>/dev/null
Oxff

$ sudo i2cget -y 1 0x20 0x02 2>/dev/null
$ sudo i2cget -y 6 0x20 0x02 2>/dev/null
$ sudo i2cget -y 4 0x20 0x02 2>/dev/null
$ sudo i2cget -y 0 0x20 0x02 2>/dev/null
$ sudo i2cget -y 7 0x20 0x02 2>/dev/null
$ sudo i2cget -y 5 0x20 0x02 2>/dev/null

4. Confirm that the PCA9536 GPIO expander board driver PCA953x is loaded using the following command:

$ lsmod | grep pca
gpio pca9563x 28672 16
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If the gpio_pca953x module is not found, load the module using the following command:

$ sudo modprobe gpio-pca953x

Confirm that the module is loaded using the following command:

$ sudo dmesg
[ 75.638778]
[ 75.638862]

grep pca9b3x
pca953x 3-0020:

pca953x 3-0020: using no AI

supply vcc not found,

using dummy regulator

5. Initialize the PCA9535 GPIO expander board using the following command:

$ echo pca9535 Sbusaddr |

For example: $ echo pca9535 0x20 |

sudo tee /sys/bus/i2c/devices/i2c-${busnum}/new_device

sudo tee /sys/bus/i2c/devices/i2c-3/new device

6. To verify that the device is active and working, use the following command:

$ sudo i2cdetect -y -r S{busnum}

For example:

$ sudo i2cdetect

0 1
00:
10:
20:
30:
40: —-- —--
505 == ==
603 == ==
708 == ==

2

3

-y -r 3
4 5 6 7 8 9 a b c¢c d e

7. Depending on the kernel version, test the GPIO port by performing the steps in one of the following:

a. To test the GPIO port on kernel version 5.13, use the following command:

sudo
echo
echo
echo
echo
echo
echo
echo
echo
echo
echo
echo
echo
echo
echo
echo
echo

Uy Uy Uy Uy Uy Uy Uy Uy Uy Oy Oy Oy O O A O

echo
echo
echo
echo
echo
echo
echo
echo

Uy Uy Uy Uy Uy Uy Oy

echo
echo
echo
echo
echo
echo

Uy Uy Uy Uy Uy U

su

181
182
183
184
185
186
187
188
189
190
191
192
193
194
195
196

out
out
out
out
out
out
out
out

in
in
in
in
in
in

VVVVVYV

VVVVVVVVVVYVYVYVYVYVYV

VVVVVYVVYV

/sys/class/gpio/export
/sys/class/gpio/export
/sys/class/gpio/export
/sys/class/gpio/export
/sys/class/gpio/export
/sys/class/gpio/export
/sys/class/gpio/export
/sys/class/gpio/export
/sys/class/gpio/export
/sys/class/gpio/export
/sys/class/gpio/export
/sys/class/gpio/export
/sys/class/gpio/export
/sys/class/gpio/export
/sys/class/gpio/export
/sys/class/gpio/export

/sys/class/gpio/gpiol8l/direction
/sys/class/gpio/gpiol82/direction
/sys/class/gpio/gpiol83/direction
/sys/class/gpio/gpiol84/direction
/sys/class/gpio/gpiol85/direction
/sys/class/gpio/gpiol86/direction
/sys/class/gpio/gpiol87/direction
/sys/class/gpio/gpiol88/direction

/sys/class/gpio/gpiol89/direction
/sys/class/gpio/gpiol90/direction
/sys/class/gpio/gpiol91/direction
/sys/class/gpio/gpiol92/direction
/sys/class/gpio/gpiol93/direction
/sys/class/gpio/gpiol94/direction
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$ echo in > /sys/class/gpio/gpiol95/direction
$ echo in > /sys/class/gpio/gpiol96/direction

Write O or 1 on the OUT port and read the IN port using the external loop back board, as shown in the following figure:

Figure 137. External loop back board and connector

echo 0 > /sys/class/gpio/gpiol8l/value
cat /sys/class/gpio/gpiol89/value

echo 1 > /sys/class/gpio/gpiol82/value
cat /sys/class/gpio/gpiol90/value

echo 0 > /sys/class/gpio/gpiol83/value
cat /sys/class/gpio/gpiol91l/value

echo 1 > /sys/class/gpio/gpiol84/value
cat /sys/class/gpio/gpiol92/value

echo 0 > /sys/class/gpio/gpiol85/value
cat /sys/class/gpio/gpiol93/value

echo 1 > /sys/class/gpio/gpiol86/value
cat /sys/class/gpio/gpiol94/value

echo 0 > /sys/class/gpio/gpiol87/value
cat /sys/class/gpio/gpiol95/value

echo 1 > /sys/class/gpio/gpiol88/value
cat /sys/class/gpio/gpiol96/value

echo 1 > /sys/class/gpio/gpiol8l/value
cat /sys/class/gpio/gpiol89/value

echo 0 > /sys/class/gpio/gpiol82/value
cat /sys/class/gpio/gpiol90/value

echo 1 > /sys/class/gpio/gpiol83/value
cat /sys/class/gpio/gpiol91l/value

echo 0 > /sys/class/gpio/gpiol84/value
cat /sys/class/gpio/gpiol92/value

echo 1 > /sys/class/gpio/gpiol85/value
cat /sys/class/gpio/gpiol93/value

echo 0 > /sys/class/gpio/gpiol86/value
cat /sys/class/gpio/gpiol94/value

echo 1 > /sys/class/gpio/gpiol87/value
cat /sys/class/gpio/gpiol95/value

echo 0 > /sys/class/gpio/gpiol88/value
cat /sys/class/gpio/gpiol96/value

onmrnkrRrnrnronrnnFRrnnonnnkFErEnNnonmnrrnnEFENMOoOMTNFREMMTOoOWrntFEWYrowvr =Wy O W

118 Setting Up the Ubuntu Operating System



b. To test the GPIO port on kernel version 5.15, use the following command:

Uy Uy Uy Uy Uy Uy Uy Uy Uy Oy Oy Oy O O A O

Uy Uy Uy Uy Uy O Uy

Uy Uy Uy Uy Uy Oy O >

Write O or 1 on the OUT port and read the IN port using the external loop back board, as shown in the previous figure.

nrnronrrnkFkPrnnRFErnNnnonmnEFErEnNnnonntEkE »rroUrUr 2 rr O Wy

sudo su

echo 693 > /sys/class/gpio/export

echo 694 > /sys/class/gpio/export

echo 695 > /sys/class/gpio/export

echo 696 > /sys/class/gpio/export

echo 697 > /sys/class/gpio/export

echo 698 > /sys/class/gpio/export

echo 699 > /sys/class/gpio/export

echo 700 > /sys/class/gpio/export

echo 701 > /sys/class/gpio/export

echo 702 > /sys/class/gpio/export

echo 703 > /sys/class/gpio/export

echo 704 > /sys/class/gpio/export

echo 705 > /sys/class/gpio/export

echo 706 > /sys/class/gpio/export

echo 707 > /sys/class/gpio/export

echo 708 > /sys/class/gpio/export

echo out > /sys/class/gpio/gpio693/direction
echo out > /sys/class/gpio/gpio694/direction
echo out > /sys/class/gpio/gpio695/direction
echo out > /sys/class/gpio/gpio696/direction
echo out > /sys/class/gpio/gpio697/direction
echo out > /sys/class/gpio/gpio698/direction
echo out > /sys/class/gpio/gpio699/direction
echo out > /sys/class/gpio/gpio700/direction
echo in > /sys/class/gpio/gpio701/direction
echo in > /sys/class/gpio/gpio702/direction
echo in > /sys/class/gpio/gpio703/direction
echo in > /sys/class/gpio/gpio704/direction
echo in > /sys/class/gpio/gpio705/direction
echo in > /sys/class/gpio/gpio706/direction
echo in > /sys/class/gpio/gpio707/direction
echo in > /sys/class/gpio/gpio708/direction

echo 0 > /sys/class/gpio/gpio693/value
cat /sys/class/gpio/gpio701l/value

echo 1 > /sys/class/gpio/gpio694/value
cat /sys/class/gpio/gpio702/value

echo 0 > /sys/class/gpio/gpio695/value
cat /sys/class/gpio/gpio703/value

echo 1 > /sys/class/gpio/gpio696/value
cat /sys/class/gpio/gpio704/value

echo 0 > /sys/class/gpio/gpio697/value
cat /sys/class/gpio/gpio705/value

echo 1 > /sys/class/gpio/gpio698/value
cat /sys/class/gpio/gpio706/value

echo 0 > /sys/class/gpio/gpio699/value
cat /sys/class/gpio/gpio707/value

echo 1 > /sys/class/gpio/gpio700/value
cat /sys/class/gpio/gpio708/value

echo 1 > /sys/class/gpio/gpio693/value
cat /sys/class/gpio/gpio701l/value

echo 0 > /sys/class/gpio/gpio694/value
cat /sys/class/gpio/gpio702/value

echo 1 > /sys/class/gpio/gpio695/value
cat /sys/class/gpio/gpio703/value
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echo 0 > /sys/class/gpio/gpio696/value
cat /sys/class/gpio/gpio704/value

echo 1 > /sys/class/gpio/gpio697/value
cat /sys/class/gpio/gpio705/value

echo 0 > /sys/class/gpio/gpio698/value
cat /sys/class/gpio/gpio706/value

echo 1 > /sys/class/gpio/gpio699/value
cat /sys/class/gpio/gpio707/value

echo 0 > /sys/class/gpio/gpio700/value
cat /sys/class/gpio/gpio708/value

oOnM-nNrFEWMLronrur P »rvr O UrUr
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Ubuntu troubleshooting

The following tasks describe how to recover from errors when using Ubuntu.

Recover from cloud-init process failure

About this task

During boot up, one of the following failure symptoms may occur:

e FEthernet ports do not work. This is due to the improper power-up and a failed cloud-init process.

e The system does not require an Ubuntu password change on first boot up. This occurs when the user logs in to the system
before the cloud-init process has finished.

To recover from these failure scenarios, perform the following steps to retrigger the cloud-init (init-local) process.

Steps

1. Run the following commands to clear the cloud-init log and clean the cloud-init process:

sudo rm -rf /var/lib/cloud/instances
sudo cloud-init clean

sudo rm /var/log/cloud-init*.log
sudo poweroff

Uy Uy Uy Uy

2. Reboot the system to start a new init-local process.

Setting Up the Ubuntu Operating System 121



	Dell Edge Gateway 3200 Software User's Guide 
	Contents
	Introduction
	Setting Up the Windows 10 Operating System
	Boot up and log in
	Factory reset
	System restore and backup recovery
	Create a recovery drive
	Create a system image
	Recover from system image

	Security Baseline settings
	4G module firmware update procedure
	5G module firmware update procedure
	Download Firmware Selector Tool and driver
	Remove old and install new drivers
	Update 5G firmware in Windows

	Disabling bands in Windows after firmware update or SIM card change
	Disable bands on 4G device in Windows
	Disable bands on 5G device in Windows

	Windows 10 IoT Enterprise LTSC basic functions
	UART controller
	TPM support
	RHProxy driver - I2C and GPIO
	System shutdown and restart
	Configure LAN network
	Optional expansion modules
	Configure WWAN network
	Enable Mobile hotspot
	Configure Bluetooth
	Cellular network configuration
	DSSA
	Accessing GPS
	Use the Unified Write Filter

	BMC firmware update procedure
	Accessing and updating the BIOS
	Access the BIOS settings
	Update the BIOS using UEFI capsule update from Windows

	SuperIO Function Library
	Windows SIO API
	SIO_WDT_Set
	I32 SIO_WDT_Set (unsigned char val, int mode)
	SIO_WDT_GetCurrentTime
	I32 SIO_WDT_GetCurrentTime (unsigned char* pTime, int* mode)
	SIO_WDT_Stop
	I32 SIO_WDT_Stop ()
	GetCurrentCPUTemp
	I32 GetCurrentCPUTemp (int *temp)
	Error codes

	Build the SIO sample application
	Execute the SIO sample application

	Digital Input/Output Function of the Intel PCH Controller
	Build the GPIO sample application
	Execute the GPIO sample application

	Digital Input/Output Function from PCA9535 GPIO
	PCA9535 GPIO Expander API
	PCA9535Init
	int PCA9535Init (unsigned int i2cnumber)
	DioSetLevel
	int DioSetLevel (unsigned char data, unsigned char mask)
	DioGetLevel
	int DioGetLevel (unsigned int mask, unsigned int* GetPinLevel)
	Error codes

	Build the PCA9535 sample application
	Execute the PCA9535 sample application

	Hardware monitor API
	EApiLibInitialize
	int EApiLibInitialize ()
	EApiBoardGetValue
	int EApiBoardGetValue (int parameter)
	EApiUnInitialize

	Humidity and temperature sensor setup
	Build the sample application
	Create the MSIX package
	Import the certificate
	Install the application
	Run the temperature sensor application

	Pressure sensor setup
	Run the pressure sensor application

	Accelerometer sensor setup
	Run the accelerometer sensor application

	Intel OOB
	Host and target setup
	Perform changes in the BIOS
	Cloud setup and configuration
	Set up Azure IoT Central for device management
	Create an OOB capsule binary

	OOB service provisioning
	Update the MAC capsule
	Update the OOB credentials capsule

	Activate OOB commands using Azure

	COM Port and Ethernet Names for Mini PCIe Cards
	Sensor APIs
	Windows troubleshooting
	Recover from Install Windows error
	Recover from .NET Framework installation error


	Setting Up the Ubuntu Operating System
	Boot up and log in
	Create bootable USB stick for restore
	Back up and restore Ubuntu 20.04 LTS
	Update BIOS capsule
	Update 4G module firmware
	Update 5G module firmware
	Disabling bands in Ubuntu after firmware update or SIM card change
	Disable bands on 4G device in Ubuntu
	Disable bands on 5G device in Ubuntu

	Ubuntu 20.04 LTS basic functions
	System shutdown and restart
	Ubuntu OTA update
	List installed packages
	Update the system name
	Change the time zone
	Root user credential
	Create new user
	Select language
	Display
	USB
	Configure humidity, pressure, and accelerometer sensors
	Configure Ethernet
	Configure WiFi network
	Configure Bluetooth
	Connect 4G or 5G WWAN
	Identify 4G or 5G module
	Use Minicom
	Use mmcli

	Change 5G SIM slot and connect to the Internet
	Set up 5G Stand-Alone mode for private networking
	Access GPS
	Use Minicom
	Use mmcli

	Remote login
	Set up audio and microphone
	SSD security-erase
	Get system current and voltage
	Connect to the serial port
	Connect to the Canbus
	Mount USB storage
	Configure watchdog
	Configure GPIO
	TPM tasks
	List PCR values
	Get random data by TPM
	Get hash by TPM

	Wake events
	Trigger Ubuntu OS to enter S3 status
	Use RTC as wake event
	Wake-on-LAN
	Wake-on-WLAN


	Isolated Canbus uFM expansion module
	EMP2-X2S1 card with isolated RS-232 uFM expansion module
	EMP2-X4S2 card with isolated RS-422/485 uFM expansion module
	Connect a PCA9535 GPIO expander board
	Ubuntu troubleshooting
	Recover from cloud-init process failure



